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This guide contains information to assist you in understanding and
using MetaCube data warehousing software.

Organization of This Guide
The chapters in this guide describe MetaCube Explorer features that allow
you to query a MetaCube data warehouse in multidimensional terms. Each
chapter contains information on using the capabilities and features of
MetaCube Explorer. Many chapters also contain tutorials that allow you to
get started using the key features of the product.

The chapters of this guide correspond to the features of the Explorer
interface. For example, the chapter titled “Stored Queries” describes the use
of the Queries Tab page of Explorer. Although this guide can be read sequen-
tially, from beginning to end, it is also designed to be used as a reference to
the features and capabilities of Explorer. The guide includes the following
chapters:

■ This “Introduction” provides an overview of the guide.

■ Chapter 1, “Overview,” provides general information about
MetaCube Explorer.

■ Chapter 2, “Getting Started with Explorer,” provides information on
the basic features of MetaCube Explorer and includes tutorials from
which to learn about those features. After reading this chapter and
doing the tutorial exercises, you should have a good understanding
of how to use MetaCube Explorer to query your DSS System and
obtain reports and charts that display the results of your queries.

■ Chapter 3, “Stored Queries,” provides information about queries
already stored in a DSS System and how to run stored queries using
Explorer’s Queries Tab page. Running stored queries is an efficient
and quick way to generate standard reports.
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Organization of This Guide
■ Chapter 4, “Filters,” describes what filters are and how they affect
the results of a query. Also, this chapter describes how to use filters
in the Filters Tab page by applying one or more to a query.

■ Chapter 5, “Explorer Analysis Features,” describes the analysis
features available to you as you specify ad hoc queries in the Ad Hoc
Tab page. These features allow you to incorporate information into a
report that enhances your ability to interpret the results generated by
the query.

■ Chapter 6, “Explorer Reports,” provides information about
Explorer’s Results Mode, where query results are displayed in
reports. It also describes format and data analysis features you can
use while viewing a report.

■ Chapter 7, “Explorer Charts,” provides information about Explorer’s
Results Mode, where query results are displayed in charts. It also
describes format and data analysis features you can use while
viewing a chart.

■ Chapter 8, “Customizing Explorer Reports,”describes ways to
customize queries. Customization features allow you to generate
reports specific to your own business analysis requirements.
Tutorials in this chapter allow you to practice using MetaCube’s
customization features.

■ Chapter 9, “Running Queries in Background,” contains a description
of MetaCube’s QueryBack feature for scheduling and running
queries in background mode, using the QueryBack Tab page.

■ Appendix A, “Formats for Numeric Data,” describes custom format
options for numeric data.

■ Appendix B, “Configuring Explorer,” contains information on
Explorer’s configuration options, known as Preferences.
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Types of User
Types of User
This guide is written for those who are responsible for analyzing data about
their company’s business. Simply storing data in a database is not enough;
the data is useful only when meaningful reports can be generated that reflect
business activity and provide a focus on important data. Such reports and
charts are the basis for timely business decisions that can affect the future of
a company.

Documentation
MetaCube product documentation contains two key components:

■ Printed documentation

■ Online help

Printed Documentation
The printed documentation for MetaCube products is divided into two
distinct types:

■ Guides for products with graphical user interfaces.

■ Manuals for application development tools.

Guides for products with graphical user interfaces contain information about
the various features of the product. This information is conceptual in nature.
These guides are designed to give you information about the purpose of the
product and what its capabilities are.

Manuals for application development tools are reference manuals that
provide technical information about the tools.
Introduction 5



Printed Documentation
In addition to this book, printed manuals for other MetaCube products
include the following:

■ MetaCube for Excel User’s Guide. This guide is written for people who
use Microsoft’s Excel spreadsheet for business analysis. After adding
in MetaCube for Excel to the Excel software, an Excel user can query
a MetaCube data warehouse in multidimensional terms to obtain
spreadsheet or PivotTable reports.

■ MetaCube Warehouse Manager’s Guide. This guide is written for the
data warehouse administrator and describes how to specify internal
information (metadata) about the data warehouse so that the
MetaCube components are able to access and graphically present the
database for querying.

■ MetaCube Data Warehouse Administrator’s Guide. This guide is written
for the data warehouse administrator. It describes the overall process
of developing a data warehouse and it introduces the tools for
managing a data warehouse—MetaCube Secure Warehouse,
MetaCube Agent Administrator, and MetaCube Warehouse
Optimizer.

■ MetaCube Application Programmer’s Manual. This manual is written
for programmers who will write custom applications that interact
with the MetaCube analysis engine. This manual describes
MetaCube’s OLE Automation programming interface.

■ MetaCube SDK for Snap-Ins Programmer’s Manual. This manual is
written for C++ programmers who will write custom measure calcu-
lations for MetaCube Explorer and MetaCube for Excel using the
MetaCube SDK for Snap-Ins. The MetaCube Extension Wizard
generates skeletal code that is a framework for adding custom C++
code for customized measure calculations.

■ MetaCube SQL Optimizer User’s Guide. This guide describes how to
use the MetaCube SQL Optimizer for connecting third-party query
tools or custom query applications to the MetaCube analysis engine
to access a MetaCube data warehouse. Queries are optimized to run
against aggregate and sample tables, thereby significantly
improving query performance against very large data warehouses.

■ MetaCube Installation and Configuration Guide. This guide describes
how to install and configure MetaCube software components on
both the database server platform and on PCs.
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Online Help
■ Introduction to New Features. This guide describes the new features
and enhancements for Release 4.0 of MetaCube. It provides infor-
mation to existing MetaCube users.

Typeface

The text in this guide uses the following set of conventions.

Online Help
Each MetaCube component that employs a graphical user interface includes
an extensive online help system that provides step-by-step instructions on
the use of the product. The help system for most MetaCube products is
accessed from the Help menu and consists of the following options:

■ Help Topics: a complete online help system that contains “how to”
topics and procedural information on using the product.

■ Context Sensitive Help: allows the user to access help specifically on
a feature of the user interface. Selecting this menu option changes the
cursor into a help cursor. Clicking a feature of the window with the
help cursor displays help about that specific feature.

■ Help on Help: For users unfamiliar with using online help systems,
contains instructions on using MetaCube online help.

Note: For MetaCube for Excel, the Help system is accessed from the MetaCube menu
in Excel. For MetaCube Web Explorer, the Help system is accessed from the Help
button on the toolbar.

Convention Meaning

italics Emphasized words appear in italics. Also used for the names of
MetaCube components and some terms that are specific to
MetaCube Web Explorer.

boldface Used for the names of menu options and popup menu options.

monospace Used for information that the product displays and information
that you type.
Introduction 7



Readme Files
Context-sensitive help can be accessed by clicking the Help button on an
application’s toolbar in the main window. After clicking the Help button,
clicking any feature of the window displays help about that specific feature.
This is the same as clicking Context Sensitive Help on the Help menu.

When a dialog box is displayed, the F1 key displays a help topic that
describes the features of that dialog box. From that topic, the user may jump
to the main help system or, in many cases, to a procedural help topic that
describes how to use the dialog box. In the main window of an application,
after activating an area of the window by clicking it, F1 provides a help topic
that describes that particular area of the window.

Readme Files
In addition to the printed manuals, readme files are distributed with
MetaCube products. These files contain technical information, including last-
minute changes to product capability or documentation. Please read these
files, as they contain important information.

Related Reading
For information on data warehousing, see The Data Warehouse Toolkit, by
Ralph Kimball (John Wiley & Sons, Inc., 1996).

Compliance with Industry Standards
The American National Standards Institute (ANSI) has established a set of
industry standards for SQL. Informix SQL-based products are fully compliant
with SQL-92 Entry Level (published as ANSI X3.135-1992), which is identical
to ISO 9075:1992, on Informix Dynamic Server. In addition, many features
comply with the SQL-92 Intermediate and Full Level and X/Open C CAE
(common applications environment) standards.

Informix SQL-based products are compliant with ANSI SQL-92 Entry Level
(published as ANSI X3.135-1992) with the following exceptions:

■ Effective checking of constraints.

■ Serializable transactions.
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Informix Welcomes Your Comments
Please tell us what you like or dislike about our manuals. To help us with
future versions of our manuals, we want to know about any corrections or
clarifications that you would find useful. Please include the following
information:

■ The name and version of the manual that you are using.

■ Any comments that you have about the manual.

■ Your name, address, and phone number.

Write to us at the following address:

Informix Software, Inc.
Technical Publications
300 Lakeside Drive, Suite 2700
Oakland, CA 94612

If you prefer to send electronic mail, our address is:

doc@informix.com

Or, send a facsimile to Technical Publications at:

650-926-6571

We appreciate your feedback.
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This chapter introduces MetaCube Explorer. This chapter discusses:

■ The two version of MetaCube Explorer.

■ Multidimensional queries.

■ The MetaCube data warehouse.

■ Filters.

■ Explorer’s two modes: Query and Results.

■ MetaCube workbooks.

■ Some MetaCube analysis features.

About MetaCube Explorer
MetaCube Explorer is a graphical data access tool that enables quick retrieval
and analysis of critical business data stored in a large data warehouse.
Explorer works with the MetaCube analysis engine to query data
warehouses stored in an Informix database. Explorer’s graphical interface
displays multiple views of the information retrieved by any query. As a
business analyst, you can:

■ retrieve results of complex queries.

■ pivot rows and columns to present data by different categories or
groupings; sort report rows and columns alphabetically, numerically,
and chronologically.

■ drill down for more detailed information or up for a more summa-
rized report.

■ incorporate calculations into reports that provide comparisons and
rankings of business data, thereby facilitating analysis of business
data.

■ customize reports to present user-defined views of data.
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A Multidimensional View of Data
■ print reports and charts.

■ export data to other business analysis tools.

MetaCube software contains two versions of Explorer:

■ Client/Server Explorer.

■ MetaCube Web Explorer.

Client/Server Explorer runs as a standalone client/server application, while
MetaCube Web Explorer runs inside a Web browser.

The user interface for the two versions is very similar. The working area of
the Explorer window looks the same for both versions, with tabs, tab pages,
an area containing drop boxes, an example report area, and a control area for
running queries. Right-click shortcut menus are also the same for both
versions. Most importantly, analysis features for the two versions are
identical.

The differences between Client/Server Explorer and Web Explorer occur in
the toolbar and the menu bar. The toolbar for Web Explorer is more extensive
and the menu bar is not used for Explorer options. When running Web
Explorer, the menu bar in the window applies to the Web browser you are
using. However, when using Client/Server Explorer, the menu bar contains
options for the MetaCube application.

A Multidimensional View of Data
MetaCube provides you, as a business analyst, a view of the information
stored in your data warehouse that matches your understanding of your own
business. If you understand your data in terms of products, time periods, and
geographic locations—that is, according to what, when, and where transac-
tions occurred—Explorer allows you to formulate queries in those same
terms.

MetaCube organizes the criteria for defining queries into dimensions. Dimen-
sions are different views of data—that is, different ways of organizing or
constraining data. For example, a geography dimension might specifically
contain information about the city, state, region, or country where business
transactions occur. MetaCube queries thus enable you to retrieve a set of data
using several different views simultaneously.
1-4 Explorer User’s Guide



A Multidimensional View of Data
The elements of a dimension are typically organized in a hierarchy. For
example, many cities belong to one state, and many states belong to one
country. Country is at the top of this geography hierarchy, city at the bottom.
Country, state, and city are, therefore, hierarchical elements in a geography
dimension.

The hierarchies in a dimension represent the various levels of detail by which
you can summarize information in a report. Using a geography hierarchy as
described above, a report retrieving sales information from the data
warehouse could summarize that data by city, by state, or by country.

One or more attributes describe each element of a dimension. For example,
the attributes city name and city size may be associated with the city element
of the hierarchy. Attribute values for city name might include values such as
“Seattle,” and “Berkeley”; attribute values for City Size might be “large” and
“small.”

Explorer presents the business data you are interested in analyzing as a set of
measures. Measures are the numeric data derived from the business transac-
tions stored in your data warehouse. Examples of measures are “gross
revenue,” “units sold,” or “net profit.”

Attributes and measures are the essential components of an Explorer query.

Attributes are sometimes referred to as “query categories.” This name
signifies that attributes are the mechanism by which MetaCube and Explorer
allow you to view, or categorize, data. The city attribute (or query category)
allows you to view data for cities; or, stated another way, data is categorized
by city. One of the powerful features of Explorer is the ability to define your
own query categories for viewing data. In effect you can define query
categories that allow MetaCube to summarize data according to your own
specification.

Measures are sometimes referred to as “query items.” Measures are the items
of data you wish to appear in your report. Explorer allows you to define
custom measures (query items). A custom query item, or user-defined
measure, is a formula that manipulates existing data in order to incorporate
other meaningful analysis data into your query results.
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The MetaCube Data Warehouse
Described below are some important concepts related to accessing a
MetaCube data warehouse.

DSS Systems
When you access a MetaCube data warehouse, your view of the data is
known as a DSS System. This name is derived from the descriptive name of
software used to query databases. MetaCube is decision support software
(DSS) and therefore, the component of the data warehouse that you can
query is called a DSS System.

Within a single DSS System, there may be one or more data sources. A data
source consists of a central table that stores business-related measure data
joined to a number of dimension and attribute tables that enable the multidi-
mensional views of data in Explorer reports and charts.

You may query a single data source or you may specify queries to retrieve
data from more than one data source that Explorer combines into a single
report.

MetaCube Data Warehouse Metadata
Metadata is an internal description of the data warehouse. Metadata is
actually stored in a set of database tables that were created when MetaCube
software was installed. As a map of the physical tables in the data warehouse,
metadata provides the information needed by the MetaCube analysis engine
to access data and optimize query processing. Moreover, because the
metadata describes the contents of database tables and columns in natural
business terms, MetaCube uses this as a map to the DSS System in order to
provide a customized view of measure data.

Your data warehouse administrator has created the metadata for the DSS
Systems you and other Explorer users in your company access. The metadata
enables Explorer to present an easy-to-use interface to the complex under-
lying database and to automatically generate all of the necessary database
commands to extract the information requested by your queries.
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MetaCube Filters
Explorer can retrieve precisely the data that you wish to analyze, and
eliminate information that is not needed. The ability to just the pertinent data
for a report or chart is achieved through the use of filters that are applied to
queries submitted to a DSS System.

Filters
Filters allow you to limit the range of data returned for any given attribute or
measure. Filters can be quite simple or very complex. For example, using
filters, a query could be specifically defined to return measures that meet
these criteria: sales of the five best-selling products for last week and for the
same week last year, for products sold in the western or southern regions.
This report would require filters on three separate dimensions. The filters
needed would retrieve:

■ the five top-selling products (from a product dimension)

■ sales information for last week and the same week a year ago (from
a time dimension)

■ data for the western and southern regions of the country (from a
geography dimension).

Filters do not influence the degree of summarization in the report or
otherwise change the organizational structure of a report. A filter defines how
much data you see, whereas the attribute defines the level of summarization for
that data.

Comparison of Time Dimensions and Time Filters
An important dimension of almost all DSS Systems is a time dimension. The
attributes of a time dimension may be specified in queries in order to
summarize data according to specific time periods.

A DSS System may also contain time filters. The function of a time filter,
however, is different. When applied to a query, a time filter eliminates data
from the report based on a specific time period.
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The Time Dimension

The time dimension in a DSS System summarizes data by time intervals. Just
as data can be categorized and summarized by city, for example, data can
also be summarized by periods of time. A time dimension is typically
organized hierarchically, just as any other dimension is. For example, a time
dimension might contain days, weeks, months, quarters, and years.

For example, a report that summarizes data by week organizes all data
retrieved from the DSS System into summarized groups based on a calendar
week.

The Time Filter

A time filter, on the other hand, actually eliminates some data from a report.
A time filter can be specified to retrieve only data for the most recent week,
for example. Using such a filter causes data on all transactions that occurred
prior to the most recent week to be excluded from a report.

Time filters can be used in conjunction with one of the time dimension
elements. For example, if a query specifies summarization of data by week
(using the time attribute of weeks in a time dimension) and uses a time filter
that eliminates all data except for the last full quarter, the resulting report
would summarize data into thirteen categories, including only those transac-
tions that occurred during the quarter.

Query and Results Modes
Explorer’s graphical user interface uses two display modes:

■ Query Mode

■ Results Mode
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Query Mode
In Query Mode, Explorer’s window allows you to perform all functions
related to queries. The drag-and-drop interface allows you to “grab” objects
using the mouse and position them in various “drop” locations in the
Explorer window.

Four tabs at the bottom of the Query Mode window allow you to pick the task
you wish to perform. You may:

■ run stored queries using the Queries Tab.

■ specify a new, ad hoc query using the Ad Hoc Tab.

■ specify and manage query filters using the Filters Tab.

■ view and manage queries you have submitted for background
processing using the QueryBack Tab.

You may also access many Explorer functions by right-clicking icons, drop
boxes, or worksheet tabs in the Explorer window. Right-clicking an object
displays a shortcut menu with options that are appropriate for the object you
clicked.

Using Client/Server Explorer, functions may be accessed from the toolbar or
from the menu bar. However, using Web Explorer, the menu bar is not used
and Explorer functions are all accessed from the toolbar. Tool tips display to
show you what operations you can perform with the buttons on the toolbar.

Results Mode
MetaCube query results are displayed in Results Mode. Explorer provides a
variety of table (or spreadsheet) and chart formats for results. In Results
Mode, you can manipulate the report table or the chart to reformat the
presentation. For example, in a report, you can pivot the data so that infor-
mation that was originally displayed in rows displays in columns or by page.
Charts in a variety of formats—pie, bar, line, and area—can be rotated to
better display relationships among data points. Reports and charts display in
color and in various font styles.
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MetaCube Workbooks
When you work with Explorer, you create and use MetaCube workbooks
that contain individual worksheets. Each worksheet in the workbook
contains a single query. After the query is run, the results of that query are
also contained in the same worksheet in the form of either a spreadsheet-like
report or a chart.

When you save the workbook, both the query and its results are saved. When
you reopen a workbook, each worksheet in it appears in the state it was in
when you saved the workbook.

Some MetaCube Functions
Explorer facilitates a wide variety of business analysis and reporting
functions. Some of them are described in this section.

Drill Up, Down, and Across
Drilling is an operation that allows you to obtain new or additional infor-
mation in a report without running or rerunning a query. The ability to “drill”
for information is possible because the elements of a dimension are typically
organized in a hierarchy (see “A Multidimensional View of Data” on
page 1-4). The MetaCube analysis engine understands the hierarchical nature
of dimensions and is able to traverse dimensions to retrieve information
summarized at different levels or to retrieve additional information.

The hierarchies in a dimension represent the various levels by which you can
summarize data in a report. You can easily “drill down” in a highly summa-
rized report, for the entire country, for example, to a more detailed level, such
as by region or by city. You can also “drill up” in a detailed report to view
more summarized data.
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Sampling and Sample Tables
MetaCube’s drill across capability provides two types of capabilities:

■ you may drill across to other dimensions in the data source in order
to increase the “dimensionality” of the results; when you add an
attribute from another dimension, summarization of data becomes
more granular;

■ you may retrieve data from another data source in your DSS System.
This allows inclusion of similar or related data in a single report for
the purposes of comparison.

Sampling and Sample Tables
Explorer’s sampling feature allows you to attain improvements in retrieval
time for queries against very large DSS Systems. During retrieval of infor-
mation from any database, performance is directly related to the number of
rows that are processed, so running against large database tables causes
queries to run slowly.

The MetaCube sampling feature provides an alternative solution for
querying very large data tables. Smaller statistically valid tables, called
sample tables, can be used instead. By running queries against these tables,
randomly generated from the larger tables, you can obtain highly accurate
results while maintaining good performance.

Your data warehouse administrator can create, for example, a sample table
containing 10,000 records, that is randomly created from an original table
containing 100,000,000 records. Processing against the smaller 10,000-row
sample table results in noticeable performance improvement.

With Explorer’s Sampling feature enabled, you can query sample tables,
indicating the level of confidence and the degree of accuracy you require, and
obtain Explorer reports many times faster than you might otherwise be able
to do.
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Measure Calculations
One of Explorer’s analysis features, called a measure calculation, allows you to
compare data in a report in terms of moving averages and sums, rankings,
and a large number of percentage and percentile calculations. Measure calcu-
lations provide meaningful insight into the retrieved data so that business
trends and other analyses can be easily seen in reports.

Custom Comparisons
Explorer provides a custom comparison feature that allows you to quickly
retrieve data for one or several attributes and display the results in the same
report.

The custom comparison is a feature that might be used to produce a report
that compares regional sales with total country sales, for example. A custom
comparison might also be used to retrieve data that shows gross revenues for
each of, say, five cities for certain products. With this information contained
in columns of the report, other analysis calculations can then be added that
compare the columns of data.

QueryBack
You can submit a query to the DSS System for background processing, using
MetaCube’s QueryBack feature. When you submit a query to QueryBack,
MetaCube:

■ schedules the query for execution.

■ stores the SQL commands in the database until they are scheduled to
execute.

■ executes the commands at a scheduled time.

■ stores the results in the database.

You may schedule a query to run in background mode, as a QueryBack job,
when you first submit it. Explorer’s QueryBack Tab allows you to view the
QueryBack queue to verify that your job is successfully submitted. Later, you
may retrieve the results of the job into a worksheet using the QueryBack Tab.
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QueryBack
Using the scheduling capabilities of QueryBack, you can generate reports on
a weekly, monthly, or quarterly basis, as well as submit long-running jobs to
process during off hours on the database server.
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This chapter is an introduction to using MetaCube Explorer. It
explains the basic features of Explorer and provides short tutorials that you
can follow, using the MetaCube demonstration database, to learn about how
to use Explorer.

After reading this chapter and doing the tutorials, you should have an under-
standing of the most important features of MetaCube Explorer. You will have
seen the two working modes of Explorer—Query Mode and Results Mode—
and understand how to run queries, change the format of reports as well as
the data contained in reports, and how to create a chart based on the data
retrieved by a query.

The examples appearing throughout this guide use the demonstration
database supplied with the MetaCube decision support software. You will
need access to this demonstration database in order to do the hands-on
tutorials provided in this guide. The demonstration DSS System consists of
two data sources; the one named Sales Transactions is used for the tutorials.
The Sales Transactions data source tracks sales of electronic equipment in two
regions and six cities in the U.S. over a time period from January 1, 1996, to
March 31, 1997. The Sales Transactions data source has four dimensions—
Product, Geography, Time, and Channel—each of which contain a variety of
attributes with which to formulate queries. The sample measure data include
Units Sold, Gross Revenue, Incurred Cost, Net Profit, and Percent Margin.

The Explorer Interface
The Explorer user interface behaves like that of most standard Windows
applications. Its window design enables operations related to running
queries, viewing reports, and designing charts. Dialog boxes enable the use
of Explorer’s analysis features.
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The Explorer Interface
Drag and drop

Much of Explorer's user interface provides standard drag-and-drop function-
ality. When you start to drag an icon, valid drop areas become highlighted
with color to indicate where you can drop the icon. You can use drag and
drop for many functions in Explorer.

Explorer toolbar and menu bar

In Client/Server Explorer, frequently used features are available from the
toolbar. MetaCube analysis functions are available from the menu bar.

In Web Explorer, all MetaCube features are available from the toolbar, since
the menu bar is for the Web browser and is not used by Web Explorer.

Other Windows interface techniques

Other standard Windows interface techniques are available in Explorer. In
Query Mode, double-clicking attribute, measure, filter, or query icons
automatically “drops” them into appropriate drop boxes in the window. In
both Query Mode and Results Mode, right-clicking attribute names or
measure names, as well as other areas of the screen, displays relevant
shortcut menus.

Tool Tips and Balloon help

For information about the individual buttons on the toolbar, position the
mouse pointer over the button. Hold the mouse stationary for a moment to
display balloon help for that button.

For a description of the icons in Explorer’s Query Mode, right-click and hold
the mouse button down over the icon you wish to learn about. Explorer
displays a short description of the item. Balloon help for DSS System icons is
specifically written by your data warehouse administrator.

Online Help for Explorer

A full online help system is available for MetaCube Explorer.

■ For Client/Server Explorer, the Help option on the menu bar
provides access to online help.

■ For Web Explorer, the Help Options button on the toolbar provides
access to online help.
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The Query Mode Screen
The Explorer online help system provides the following:

■ Help Topics: the full help system for Explorer. Contains step-by-step
instructions for performing function in Explorer as well as infor-
mation on how to get started using Explorer.

■ Context Sensitive Help: allows you to click on a feature of the
Explorer main window to get information specifically about that
feature. You can also get context sensitive help by clicking the
Context Sensitive Help button on the toolbar.

■ Help on Help: a help system on using Windows Help. If you are
unfamiliar with using Windows online help systems, Help on Help
can assist you.

In Explorer dialog boxes, you can obtain a description of the features of the
specific dialog box you are viewing by pressing the F1 key. Many help topics
for dialog boxes contain Related Procedure buttons that display step-by-step
procedures for using the dialog box. The Contents button displays the
contents for the Main Topics help system, where you can access any help
topic available for Explorer.

Note: The F1 key to access online help does not function in the main Explorer
window.

The Query Mode Screen
Explorer’s Query Mode screen is designed to allow you to perform all the
MetaCube operations and analysis functions related to specifying and
running queries.
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The Query Mode Screen
Figure 2-1 Query Mode screen

The screen is divided into two main sections:

■ the Tab area, with four tabs and their corresponding Tab pages.

■ the Query Definition area, with drop boxes, a Control area, and an
Example Report display.

Tab area Query Definition area
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The Query Mode Screen
The Queries Tab

This tab is related to running stored queries. Stored queries are defined by
your data warehouse administrator and are saved in the database. They are
displayed in the Queries Tab page in a directory that is much like the file
directory on your Windows PC.

Figure 2-2 The Queries Tab page

The icons in the Queries Tab page represent previously specified queries
stored in the DSS System. You can submit a stored query as-is, or you can
modify it before you run it. Stored query icons are organized in folders and
sub-folders.
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The Query Mode Screen
Other features of the Queries Tab page include:

■ the Look in box displays the name of the current folder whose
contents are displayed on the Tab page.

■ a toolbar allows you to:

❑ go up one level to the next-higher folder.

❑ create a new folder.

❑ copy the selected query.

The Ad Hoc Tab

This tab is related to specifying your own ad hoc queries. The DSS System
hierarchy is displayed in a directory-like format.

Figure 2-3 The Ad Hoc Tab page

Attributes

Measures

Data source

Data source

Dimension

Dimensions

DSS System

Attributes
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The Query Mode Screen
The icons in the Ad Hoc Tab page represent the following components of a
DSS System:

■ The DSS System itself, at the top

■ Data sources

■ Dimensions

■ Attributes

■ Measures

Within each dimension, attribute icons reflect the hierarchy for that
dimension. The icon at the top of the hierarchy represents the attribute that
summarizes data at the highest level. The icon at the bottom of the hierarchy
represents the attribute that summarizes data at the lowest level, that is,
provides the most detailed data. Measure icons represent the data stored in
the DSS System; measures are the actual data that appear in a report or chart.

The Filters Tab

This tab is related to applying pre-defined filters to queries and specifying
your own filters. Icons representing filters currently available to you are
displayed in a directory that looks and behaves much like the file directory
on your Windows PC.
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The Query Mode Screen
Figure 2-4 The Filters Tab page

In the Filters Tab page, the icons represent previously specified filters that
you can apply to queries before submitting them.

Other features of the Queries Tab page include:

■ the Look in box indicates the name of the current folder whose
contents are displayed on the Tab page.

■ a toolbar allows you to:

❑ Go up one level to the next higher folder.

❑ Create a new folder.

❑ Create a new filter.
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The Query Mode Screen
The QueryBack Tab

This tab is related to submitting queries for background (or QueryBack)
processing on the server. When you schedule a query to run in background
mode, it is queued on the server and then run at a scheduled time. After the
query has finished, you can retrieve the results from this tab page.

Figure 2-5 QueryBack Tab page

In the QueryBack Tab page, the queue for background (QueryBack) jobs is
displayed, showing the name of the query’s worksheet and the query’s status
in the QueryBack job queue. The job’s status might be one of the following:

■ Pending—the job is waiting in the queue.

■ Running—the job is currently running.

■ Finished—the job has finished and you can retrieve results.
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The Query Mode Screen
■ Unknown—the exact status of the job cannot be determined.

■ Error—an error occurred while the job was running.

In the QueryBack Tab page, you can view the queue in two ways:

■ For job(s) scheduled from the current worksheet only.

■ For all worksheets from which QueryBack jobs were scheduled.

Query Definition Area

The Query Definition area of the Query Mode screen graphically displays the
components of a query.

Figure 2-6 Query Definition Area

The drop boxes in the Query Definition area are populated by dragging icons
to them or by double-clicking an icon. When double-clicked, icons such as a
stored query icon in the Queries Tab, attribute or measure icons in the Ad
Hoc Tab, or filter icons in the Filters Tab, are automatically placed into the
appropriate drop boxes. Double-clicking an attribute icon always places it in
the Rows drop box; you may drag it from there to another drop box, if you
wish.
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The Query Mode Screen
Control Area

The Control Area is where you specify an action for Explorer to perform:

■ run a query in foreground mode.

■ schedule a query to run as a QueryBack job.

■ specify using MetaCube’s Sampling feature when a query is run.

Figure 2-7 Control Area

The Control area displays the name of the current query. Explorer’s default
query name is Query1, as shown in Figure 2-7. The area where the query
name displays is actually the Query Drop Box. In preparation for running a
stored query, you can drag and drop a stored query icon into the Query Drop
Box, populating other drop boxes in the Query Definition area with the
components of the stored query. When you start to drag a stored query icon,
the Query Drop Box highlights to indicate that you can drop the icon there.
You can run the query, as-is, or modify it before running.

After populating the drop boxes in the Query Definition area, you can run a
query in foreground or background mode. After clicking Run, the query runs
immediately and Explorer waits for results to be returned.

You can schedule a query to run in background mode at a specified time by
clicking the Schedule button. This allows you to specify the exact time the
query should run. Explorer does not wait for results, so you can continue to
work with other queries and reports.

If you specify the use of MetaCube’s Sampling (or Estimate Results) feature,
you can improve performance when running a query. The Sampling feature
must be enabled in Explorer and your DSS System must be implemented to
support it. Before using this feature, verify with your data warehouse admin-
istrator that this feature can be used for the DSS System you are accessing.
Getting Started with Explorer 2-13



The Query Mode Screen
Example Report

Below the Query Definition area, an Example Report displays a preview of
the format of the report Explorer will generate when you run the query.

Figure 2-8 Example Report

When you specify a query, you define not only the set of data to be retrieved
but also the initial format of the resulting Explorer report. The Example
Report enables you to see how placing attributes in Rows, Columns, or Pages
drop boxes affects the report’s appearance. As you drag icons among the
drop boxes, the Example Report dynamically reformats.

The Example Report does not display actual data. To display actual data, you
must run the query, thereby generating either a report or a chart.
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The Query Mode Screen
Attribute Formats

If you drop an attribute icon into a Rows drop box, each attribute value
generates a row in the report with the actual values in the left-most cells as
row headings. If you drop more than one attribute icon into the Rows drop
box, Explorer automatically creates a break report, with subordinated rows.

Figure 2-9 Break Report

A break report is a suitable format for applying subtotals, as shown in the
example in Figure 2-9.

If you drop an attribute icon into a Columns drop box, each attribute value
generates a column in the report with the value, itself, on top as a column
heading. You can easily create cross-tabular reports by arranging attributes
in both columns and rows. You can create a break report using columnar
format, as well.

If you drop an attribute icon into a Pages drop box, Explorer generates a
multipage report with data for each attribute value on a separate page.

Measure Format

You can select as many measures as you wish for a query by dropping their
icons into the Measures drop box. If a query contains multiple measures, each
measure appears as a separate column in the report, with the values for that
measure populating the cells in that column.
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MetaCube Workbooks
Whenever you use Explorer, you are working in a MetaCube workbook. A
workbook contains one or more worksheet. A worksheet may display one of
the following:

■ A query that is defined but not yet run.

■ A report displaying query results.

■ A chart displaying query results in chart form.

Therefore, a workbook is a collection of queries, reports, and charts.

■ If you are using Client/Server Explorer, you may open more than
one workbook at a time. The Windows menu option displays the
names of all open workbooks and you can click a name to display a
specific workbook.

■ If you are using Web Explorer, you may open only one workbook at
a time.

When you save a workbook, which you can do at any time, the data that is
the basis for reports and charts is saved with it. When you reopen the
workbook, reports and charts are displayed again, using the saved data.

Workbooks are DSS System-specific and contain only queries that run against
a single DSS System. If you change DSS Systems, you must use a different
workbook.

Explorer saves workbooks using the filename extension .mcw; therefore, you
can easily identify MetaCube workbooks from your Windows desktop. You
can open an existing workbook in one of two ways:

■ Double-click the filename of the workbook you wish to open.

■ Start Explorer, then open the workbook you wish to use.
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Worksheets
Worksheets
Each separate worksheet in a MetaCube workbook contains one and only
one underlying query. When you are working with queries and the Query
Definition Area drop boxes are displayed, the worksheet is in Query Mode.
When you run the query, Explorer changes the worksheet to Results Mode
and displays either a report or a chart.

Every individual worksheet has its own tab. In a workbook with multiple
worksheets, you display a worksheet by clicking its tab. This causes Explorer
to bring the worksheet forward and display its contents.

Printing a Worksheet
You can print reports and charts from Explorer as you do from any standard
Windows application. Explorer uses defaults for the format, page
numbering, and title of your printed report. You can change the defaults
when you print.

Tutorial: Your First Query
Follow the steps below to design an Explorer ad hoc query to run against the
MetaCube demonstration database. The report you generate from the query
will contain the following information:

■ Within each sales district, the gross revenues, by company, for all
products sold

■ Summarized information according to sales channels—department
stores, warehouse stores, and retail chains

For this tutorial, you will use the Sales Transaction data source within the
MetaCube Demo DSS System.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.
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Tutorial: Your First Query
Tutorial Steps:

1. Start the version of Explorer that you use on your PC.

a. Log into the data warehouse by entering your user ID and
password.

b. Click the Connect button.

2. To open a new workbook:

■ For Client/Server Explorer, click the New Workbook button on
the toolbar.

■ For Web Explorer, a new workbook opens automatically when
you start Web Explorer.

3. To specify an ad hoc query, you will work in the Ad Hoc Tab page of
Explorer’s Query Mode. Click the Ad Hoc Tab.

4. To display the objects in the Sales Transactions data source, click the
+ expander button or double-click its icon.

5. To find the number of items sold, drag the Units Sold measure icon
to the Measures drop box. You can also double click the icon;
Explorer automatically places the icon in the Measures drop box.

6. To find out brand sales within each region, you will use the Region
and the Brand attributes.

a. Expand the Geography dimension by clicking the + expander
button or double clicking the Geography dimension icon.

b. Drag the Region icon to the Rows drop box (or double-click the
Region icon).

c. Expand the Product dimension icon.

d. Double-click the Brand attribute to place it in the Rows drop box.

Tip: You can remove icons from the drop boxes by doing the following:

1. Right-click the icon you wish to remove.

2. Click Remove in the shortcut menu.

Tip: You can rearrange attribute icons by dragging them from one drop box to
another or by dragging one icon on top of or under another.
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Tutorial: Your First Query
7. Notice the example report area that previews the report your query
will produce.

Figure 2-10 My first ad hoc query

The Explorer Query Definition Area should look like Figure 2-10.

8. To run your first ad hoc query, click the Run button in the Control
Area.
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Tutorial: Your First Query
Tip: Sometimes, when you run a query, you may receive the following warning,
called the Slow Query Warning.

Figure 2-11 Slow Query Warning

The warning is generated by Explorer based on configuration values set for the
MetaCube demonstration database. For these tutorial examples, you can ignore the
warning. Click the Run Anyway button.

9. If necessary, enlarge Explorer’s Results Mode screen to view the full
report.

Figure 2-12 Results of running My First ad hoc Query

Figure 2-12 shows how your report should look.

10. To return to Query Mode, do one of the following:
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■ Right-click the worksheet tab, then click Query Mode on the shortcut
menu.

■ Click the Query Mode button on the toolbar.

11. Close Explorer, if you wish; or, leave it open for the next tutorial
exercise in this chapter.

What’s In Your DSS System?
You can view the organization of the dimensions and the attribute values in
a DSS System by specifying a query that contains only the attributes from a
single dimension and requests no numeric data (that is, no measures).

For example, using the MetaCube demonstration database, you might view
the following attribute values in the Geography dimension:

■ names of all regions

■ names of all districts

■ names of all cities

Tutorial: Attribute-only query
For this tutorial, you will use the Sales Transaction data source within the
MetaCube Demo DSS System. You will specify and run an attribute-only
query on the Geography dimension.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

1. Start Explorer and, if necessary, open a workbook.

2. If necessary, display a new worksheet by clicking the New
Worksheet button on the toolbar.

3. To specify a query to display attribute values for the Geography
dimension, double-click the Region, District, and City attribute icons
so that they automatically appear in the Rows drop box.

4. Run the query.
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The resulting report is shown in Figure 2-13 below.

Figure 2-13 Attribute-only query

This report shows the two regions, the three districts, and the six cities in the
MetaCube demonstration database. The report reflects the hierarchical
nature of the Geography dimension as well as showing which districts are in
the two regions and which cities are in the three districts.

Explorer Reports
When results of a query are returned, Explorer displays them in its report
screen, which looks very different from the Query screen. When displaying a
report, Explorer is in Results Mode. In Results Mode, all functions required
for modifying reports are available.

Explorer’s Results Mode allows you to:

■ apply different formatting to display your report

■ view additional data that you did not originally request in your
query.

Tutorial: Your First Report
Follow the steps below to specify an Explorer query to run against the
MetaCube demonstration database and return a report that contains the
following information:

■ within each sales district, gross revenues, by company, for all
products sold.
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Tutorial: Your First Report
■ summarized information according to sales channel—department
stores, warehouse stores, and retail chains.

For this tutorial, you will use the Sales Transaction data source within the
MetaCube Demo DSS System.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. In Explorer, open a workbook, if necessary.

2. To display a new worksheet, click the New Worksheet button on the
toolbar.

3. To display the Ad Hoc Tab page, click its tab.

4. Expand the Sales Transactions data source icon and its dimension
icons, as needed, to complete the steps below.

5. To find out gross revenues for the products sold, double-click the
Gross Revenues measure icon to place it in the Measures drop box.

6. To organize data first by district, then by company, use the District
and Company attributes. Double-click the District attribute in the
Geography dimension, then double-click the Company attribute in
the Product dimension.
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Tutorial: Your First Report
7. To subdivide all gross revenue information by sales channel, use the
Channel attribute in the Channel dimension. Drag the Channel
attribute to the Columns drop box. Or, you can double-click the
Channel attribute, then drag it from the Rows drop box to the
Columns drop box.

Figure 2-14 Example report

Notice the example report that shows you a prototype of the report
your query will produce.

Figure 2-15 Query definition for your first report

The query definition itself is shown in Figure 2-15.
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The Report Screen
8. To run the query, click the Run button.

Figure 2-16 Your first report

The report should look like Figure 2-16.

The Report Screen
Notice the features of the report screen. In the center of the screen is the report
itself. In the upper right and left corners as well as the lower left corner of the
screen are “pivot handles” that allow you to reformat the appearance of the
report by rearranging information into different columns, rows, or pages.

■ The pivot handles in the upper right-hand corner are related to infor-
mation that is displayed in columns.

■ The pivot handles in the lower left-hand corner are related to infor-
mation that is displayed in rows.

■ The pivot handle in the upper left-hand corner is related to infor-
mation that is displayed by page.
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You can reorganize information in a report by dragging attribute and
measure names from one pivot handle to another pivot handle.

Tutorial Steps (continued):

9. To display your report by page, drag the Channel attribute name
from the column pivot handle in the upper right-hand corner to the
page pivot handle in the upper left-hand corner. Position the cursor
so that the color of the pivot handle changes to yellow.

Tip: Explorer highlights valid drop areas when you are reformatting a report using
the pivot handles. When the pivot handle color is yellow, you may drop the object you
were dragging.

Your report should look like Figure 2-17.

Figure 2-17 Reformatted report; displayed by page

Notice the page heading and page count boxes. On each page of your
report, gross revenues are reported for one of the three outlet
channels: Department Stores, Retail Chains, and Warehouse Stores.
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The Report Screen
10. To display the three pages of your report, click the arrow buttons
right and left to display next and previous pages.

11. On the Department Stores page, pivot the rows so that district figures
display in separate columns. Drag the District name from the row
pivot handle in the lower left-hand corner to the empty column pivot
handle in the upper right-hand corner. Position the cursor so that the
color of the pivot handle changes to yellow.

Page 1 of your report should look like Figure 2-18.

Figure 2-18 Pivoted report on department stores page
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12. On the Department Stores page, drill down in the company data to
display gross revenues by brands for all companies:

a. Click the cell containing the company name Electrotron Inc.

b. Click the Drill Down button on the toolbar.

Your report should look like Figure 2-19. The company names are
replaced by the brand names Delmore and Techno Components.
These are the two brands of the Electrontron Inc. company. Gross
revenues are reported by brand rather than by company. There is
more detail in this report.

Notice that Explorer has created a new worksheet. When you
perform a drill operation, Explorer automatically generates a new
query to retrieve more detailed information. The new query is
contained in the new worksheet.

Figure 2-19 Report after drilling down for more detailed information
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13. On the Department Stores page, drill up to display the company
gross revenue figures again:

a. Click on one of the brand names, such as Delmore.

b. Click the Drill Up button on the toolbar.

The resulting report, which displays in a new worksheet, looks as it
did before you drilled down.

14. To return to Query Mode, do one of the following:

■ Right-click the bottom of the worksheet, then click Query Mode
on the shortcut menu.

■ Click the Query Mode button on the toolbar.

15. Close Explorer or leave it open for the next tutorial exercise in this
chapter.

Explorer Charts
You can choose to generate a chart rather than a report to display the results
of your query. Explorer’s charting option provides the following formats:

■ Pie chart and 3D pie chart

■ Bar chart and 3D bar chart

■ Line chart and 3D line chart

■ Area chart and 3D area chart

Explorer displays the data from your query by creating a chart in the style
you select. In addition, Explorer’s chart feature has extensive editing and
formatting capabilities that allow you to modify the appearance of your chart
directly in Results Mode.

The chart in Figure 2-20 is a two-dimensional bar chart graphing the data
retrieved from Your First Query.
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Figure 2-20 Sample Explorer 2D bar chart

Tutorial: Your First Chart
Follow the steps below to specify an Explorer query to run against the
demonstration database and display the result set as a 2D bar chart. The chart
will display the following information:

■ for all districts, unit sales, by company, for company, for all products.

■ summarized data by the three sales channels.

For this tutorial, you will use the Sales Transaction data source within the
MetaCube Demo DSS System.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.
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Tutorial Steps:

1. If necessary, open a workbook and display a new worksheet.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and its dimension icons,
as needed, to complete the steps below.

4. To define the query for the chart:

a. Double-click the Units Sold measure icon to place it in the
Measures drop box.

b. Double-click the District attribute icon to place it in the Rows
drop box.

c. Double-click the Company attribute icon to place it in the Rows
drop box.

d. Drag the Channel attribute icon to the Columns drop box.

5. To run the query and display the results as a 2D bar chart:

a. For Client/Server Explorer, click the 2D Bar Chart button on the
toolbar.

b. For Web Explorer, click the Choose Report or Chart button on the
toolbar, then click Bar on the menu.

6. Enlarge the Explorer window, if needed, for a better view of the
display.

7. To change Explorer’s default title for the bar chart, double-click the
default title. In the Text tab of the Format Title dialog box, highlight
the default title in the text box and replace it with the title you would
like to use—such as My First Chart.

8. Click OK.
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9. To display the legend:

a. Right-click anywhere within the chart’s border and click Legend
on the context menu.

b. In the Format Legend dialog box, in the Location tab, click the
Visible box to enable it.

c. To position the Legend text box, click the Top button.

d. Click OK.

Your chart should look similar to Figure 2-21.

Figure 2-21 My First Chart

Tip: To resize areas of the chart, click the area and drag the handles. Areas you can
resize in a chart are the title, the legend, and the chart itself. Move areas by dragging
them with the mouse.
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10. Rename your chart worksheet:

a. Right-click the worksheet tab, then click Rename Worksheet on
the shortcut menu.

b. In the Rename dialog box, type the new name. The new name is
reflected immediately in the worksheet tab.

11. To access the Explorer Save feature:

a. For Client/Server Explorer, click the Save Workbook button on
the toolbar.

b. For Web Explorer, click the Save Options button on the toolbar,
then click Save Workbook.

12. To save the workbook, type the name of the workbook in the text box
of the Save Workbook dialog box.

You do not need to type the .mcw filename extension; when Explorer
saves the workbook, it adds the filename extension automatically.

13. Close Explorer.
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This chapter provides information about using stored queries to
produce standard Explorer reports. This chapter discusses:

■ how to use stored queries.

■ public and private stored queries.

■ modifying and saving stored queries.

In this chapter are some tutorials that provide the opportunity to practice
using stored queries.

Stored Queries
A stored query is a query saved in the database. Icons representing stored
queries display in the Queries Tab page. A stored query can be run as-is, or it
may be modified before running. Running stored queries is the fastest way to
produce Explorer reports, since the query is already defined. Queries for
generating standard reports that you wish to produce and analyze
repeatedly should be saved as stored queries.

Stored queries may be run in foreground, to obtain results immediately, or
scheduled as QueryBack jobs to run once or on a recurring basis. See
Chapter 9, “Running Queries in Background,” for information on
MetaCube’s background processing capabilities.
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Stored Queries
Figure 3-1 Queries Tab page and Query Definition area

A query definition must consist of at least one attribute and one measure.
Typically, however, queries contain more than one of these categories, and
possibly one or more filter.

In Figure 3-1 shows the Queries Tab page with the Query Definition area
populated with the components of a stored query. It contains:

■ three attributes; two in the Rows drop box and one in the Columns
drop box.

■ two measures in the Measures drop box.

■ two filters in the Filters drop box.
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Stored Queries
Figure 3-2 Query Definition area in Explorer

Implicit in the definition of a query is information that allows Explorer to
format the report generated by the query. The Rows, Columns, and Pages
drop boxes for attribute icons become formatting instructions for Explorer
that indicate the orientation of that information in the report.

Figure 3-3 Report generated by query in Figure 3-2

Figure 3-3 shows the report that results from running the query shown in
Figure 3-2. Each brand name is placed on the left of its row, as a heading; each
region name appears as a heading at the top of a column. The measure data
is oriented by column.
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Multipage reports can be specified in a query, as well. If an attribute icon is
placed in the Pages drop box, data in the resulting report contains separate
pages for each attribute value.

Tutorial: Running a Stored Query
Follow the steps below to learn about using stored queries in a DSS System.
For this tutorial, you will use the Sales Transaction data source with the
MetaCube Demo DSS System in the MetaCube demonstration database.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. Start the version of Explorer that you use on your PC.

a. Log into the data warehouse by entering your user ID and
password.

b. Click the Connect button.

2. To open a new workbook:

■ For Web Explorer, when you started Web Explorer, a new
workbook opened automatically.

■ For Client/Server Explorer, click the New Workbook button on
the toolbar.

3. To run a stored query, you will work in the Queries Tab page of
Explorer’s Query Mode. If the Queries Tab page is not displayed,
click the Queries Tab.

4. To display the stored queries available to you, double-click the
Public Queries folder.

5. Select the Brand Region Units Sold query by double-clicking its icon.
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6. Notice the components of this stored query:

■ Brand attribute icon appears in the Rows drop box.

■ Region attribute icon appears in the Columns drop box.

■ Units Sold measure icon appears in the Measures drop box.

■ Current Week filter icon appears in the Filters drop box. This
filter is stored as part of the query and causes Explorer to retrieve
data only for the current week. Filters are discussed in depth in
Chapter 4, “Filters.”

7. To run this query, click the Run button.

The results of this query are shown in Figure 3-4.

Figure 3-4 Stored query results

Notice how the report is formatted, based on where components of
the query appeared in Query Mode:

■ Brand attribute values appear as headings for rows.

■ Region attribute values appear as headings for columns.

■ Units Sold measure data appears in columns.

8. Close Explorer; or leave it open for the next tutorial in this chapter.
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Saving and Using Queries
As part of your company’s DSS System, your data warehouse administrator
may have provided a set of stored queries that you, and other Explorer users
in your company, can run at any time. This set of queries might, for example,
produce standard charts and reports used in your company. It is efficient, in
this case, to store shared queries in a central location, accessible by all
Explorer users.

When queries are saved in the database, only the query specification is saved;
data returned by running the query is not saved. Therefore, every time you
run a stored query, you retrieve into your workbook the latest data available
in your DSS System.

By contrast, when you save a MetaCube workbook, you also save queries —
one per worksheet. Saving a MetaCube workbook does not save queries to
the database. If you have run the query, each worksheet also saves the data
you retrieved. The data remains in the workbook until you rerun the query,
when it is replaced by new data. General information about Explorer
workbooks is contained in Chapter 2, “Getting Started with Explorer.”

Public and Private Queries
All Explorer users accessing the same DSS System have access to the public
queries stored there. Public queries are created by your data warehouse
administrator.

You may save your own queries in the same central location where public
ones are saved. Queries you save in the database are private queries, acces-
sible only by you and not by other Explorer users. You may save, delete, and
modify your private queries. Private queries are accessible for all workbooks
you create while accessing the DSS System where they are saved.

Note: Your data warehouse administrator may have developed some guidelines for
saving queries in the database; be sure you are familiar with these before you save
queries in the database.
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The Query Icon
All icons for stored queries display in the Queries Tab page. Query icons that
display without color, that is, black and gray, represent public queries. These
queries are accessible by all users of the DSS System. You can change a public
query before running it, but the changes cannot be saved. You cannot modify
a public query directly, although you can make a copy of it and save it, with
modifications, as your own private query.

Query icons that display in color represent queries you have saved—that is,
your own private queries. Private queries are only accessible by you; they are
not available for other Explorer users, even though they are accessing the
same DSS System.

Using Folders
When you save queries in the database, they are stored in folders and
subfolders organized in a tree structure. The top-level folder is named ROOT;
you can create subfolders in which to organize saved queries. Your data
warehouse administrator may have created subfolders in which to save your
queries.

A DSS System has a single set of folders and subfolders and all users of that
DSS System can see all folders. Folders are used to store both queries and
filters (see Chapter 4, “Filters” for information on public and private filters).

Listed below are some important things to understand about MetaCube
folders and the objects stored in them:

■ In Explorer, there is no such thing as a private folder. All folders are
visible to all Explorer users.

■ When working in the Queries Tab page, icons that represent filters
are not visible. The same is true when working in the Filters Tab
page: query icons are not visible.

■ Icons for your own private queries are visible only to you. Similarly,
icons for other Explorer users’ private queries are visible only to
them. Because of this, no single user can view the entire contents of
the DSS System’s folders.
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■ A folder cannot be deleted unless it is empty. Because you may not
be able to see all the objects in a folder, it may appear to be empty
when it isn’t. That is, you may delete all your private queries from a
given folder so that it appears empty to you. However, if another
Explorer user has stored objects in that folder or if it contains any
filter icons, it is not really empty and cannot be deleted.

Tutorials: Working with Stored Queries
Follow the steps below to learn about using Stored Queries in a DSS System.
For this tutorial, you will use the Sales Transaction data source with the
MetaCube Demo DSS System in the MetaCube demonstration database.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial: Saving a Query
In this tutorial, you will specify and save a private query. Then, you will run
it.

Tutorial Steps:

1. Start Explorer and open a workbook, if necessary.

2. Open a new worksheet by clicking the New Worksheet button on the
toolbar.

3. To specify a query:

a. Click the Ad Hoc Tab.

b. Expand the Sales Transactions data source directory and the
dimensions within it, as needed, to specify an ad hoc query.
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4. Specify the following query:

a. Double-click the City attribute icon in the Geography dimension.

b. Drag the Company attribute icon in the Product dimension to the
Columns drop box. (You can also double-click the icon, then
drag it from the Rows drop box to the Columns drop box.)

c. Double-click the Units Sold measure icon.

5. Access Explorer’s Save function:

■ For Client/Server Explorer, click the Query menu, then click the
Save to Database option.

■ For Web Explorer, click the Save Options button on the toolbar,
then click Save Query.

6. In the Save Query dialog box, type a name for the query, such as My
Stored Query, then click OK.

7. Click the Queries Tab.

8. Display the ROOT level of the Queries directory tree and notice the
colored icon representing your stored query. A colored query icon
represents a private stored query.

9. Open a new worksheet by clicking the New Worksheet button on the
toolbar.

10. Double-click the icon for your stored query.

Explorer populates the drop boxes in the Query Definition area with
the components of the query and displays its name in the Query
Drop Box.

11. Run the query.

Tip: Sometimes, when you run a query, you may receive the following warning,
called the Slow Query Warning.

Figure 3-5 Slow Query Warning
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The warning is generated by Explorer based on configuration values set for the
MetaCube demonstration database. For these tutorial examples, you can ignore the
warning. Click the Run Anyway button.

12. Close Explorer, if you wish, or leave it open for the following tutorial.

Tutorial: Modifying a Public Query
In this tutorial, you will access a public query, modify it by removing the filter
applied to it, then save it as your private query.

Tutorial Steps:

1. If Explorer is not already open, open it. Open a workbook, if
necessary.

2. Open a new worksheet, if necessary, by clicking the New Worksheet
button on the toolbar.

3. Click the Queries Tab.

4. To access a public query:

a. Double-click the folder named Public Queries.

b. Double-click the gray-and-black icon for the Retailer Brand by
Region public query icon.

5. To remove the filter from the query:

a. Right-click the Current Week filter icon in the Filters drop box.

b. Click Remove in the shortcut menu.

6. To access Explorer’s save function:

■ For Client/Server Explorer, click the Query menu, then click the
Save As to Database option.

■ For Web Explorer, click the Save Options button on the toolbar,
then click Save Query As.

7. In the Save Query dialog box, type a name for the query, such as My
Private Query, then click Save or OK.

8. Display the ROOT level of the Queries directory tree and notice the
colored icon for your saved query. A colored query icon represents a
private query.

9. Close Explorer.
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This chapter provides information about filtering Explorer queries.
Topics discussed in this chapter include:

■ how filters work.

■ public and private filters.

■ default filters.

■ specifying filters.

■ parameterized filters.

■ filtering on time.

In this chapter are some tutorials that provide the opportunity to practice
using filters.

Filtering Result Sets
When a filter is applied to a query, it places a constraint on the range of values
retrieved by that query. A filter narrows the scope of a query, returning a
subset of the total data a query might otherwise return. Explorer’s filtering
capability provides a high level of control over the contents of a report—your
query can retrieve only the data pertinent to the specific analysis you wish to
perform.

Filters may be defined for dimensions (using attribute values as the basis for
the filter) or for data sources (using measures within that data source as the
basis for the filter).

In Query Mode, icons representing filters display in the Filters Tab page. If a
filter has been applied to a query, its icon appears in the Filters drop box.
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Filtering Result Sets
Figure 4-1 Query Definition area with San Francisco and Current Time filter

The query specification shown in Figure 4-1 returns Net Profit information
for the city of San Francisco and for the current week. Data for cities other
than San Francisco or for weeks other than the current one do not appear in
the report.

Attribute filters are defined on a dimension-by-dimension basis. That is, a
single filter constrains data for only the attributes contained in one
dimension. You can apply multiple filters to a query, however; in fact, every
dimension in a query may be filtered, if you wish. Attribute filters are
available throughout an entire DSS System.

Measure filters can be defined for any measure in a given data source.
Measure filters only apply for a single data source, not the entire DSS System.

Your DSS System may contain some previously defined filters, developed
and made available to you by your data warehouse administrator. You can
also create your own filters.
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Public and Private Filters
All Explorer users accessing the same DSS System have access to the public
filters stored there. Public filters are created by your data warehouse
administrator.

You may save your own filters in the same central location where the public
ones are saved. Filters you save in the database are private filters, accessible
only by you and not by other Explorer users. You may save, delete, and
modify your private filters. Private filters are accessible for all workbooks
you create while accessing the DSS System where they are saved.

If you wish to modify a public filter, you may copy it, modify it, and then save
it back to the database as your private filter.

Note: Your data warehouse administrator may have developed some guidelines for
saving filters in the database; be sure you are familiar with these before you save
filters in the database.

The Filter Icon
All icons for filters display in the Filters Tab page. Filter icons that display
without color, that is, black and gray, are public filters that were created by
your data warehouse administrator and are accessible by all Explorer users.
You cannot modify a public filter, although you can make a copy of it and
save it, with modifications, as your own private filter.

Filter icons that display in color represent filters you have saved—that is,
your own private filters. Private filters are only accessible by you; they are not
available for other Explorer users, even though they are accessing the same
DSS System as you.

Default Filters
A default filter is an attribute filter that is automatically in effect when you
first start Explorer. Default filter icons appear in the Filters drop box in Query
Mode. You, or your data warehouse administrator, may designate one or
more default filter for the copy of Explorer that runs on your PC.
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When you set a filter as your default, it is your default whenever you log in
to the DSS System using the same user ID you used when you set the default.
You may designate either public or private attribute filters as default filters.

Note: A measure filter cannot be designated as a default filter.

If you, or your data warehouse administrator, have designated one or more
default filter, the icon for these filters has a different appearance. A check
mark appears over the standard filter icon. If a public filter is designated as a
default filter, the icon is gray and black; if a private filter is designated as a
default filter, the icon is colored.

Tutorial: Filtering a Query
Note: To do the tutorials in this chapter, you must have started Explorer and be
accessing the MetaCube Demo DSS System. If necessary, ask your data warehouse
administrator to configure your version of Explorer to access the MetaCube Demo
DSS System in the MetaCube demonstration database.

In this tutorial, you will use a public query and apply an existing filter to it.

Tutorial Steps:

1. Start Explorer and, if necessary, open a new workbook.

2. Click the Queries Tab.

3. To access the stored query Brand Region Units Sold, double-click its
icon in the Public Queries folder in the Queries Tab page.

When this query is run, it produces the report shown in Figure 4-2.
This report shows unit sales by brand for both sales regions—
Northeast and West—for the current week. The query already
contains a filter that retrieves only the current week’s data.
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Filter Definition
Figure 4-2 Brand Region Units Sold report

4. To filter this query to show sales only for the Northeast region:

a. Click the Filters Tab.

b. Double-click the Northeast filter icon in the Public Filters folder.

5. Run the query.

Notice that the resulting report lists one column of Units Sold data—
for the Northeast Region. Because of the filter you applied to the
query, all data for the West Region was eliminated from the report.

6. Close Explorer; or leave it open to do the next tutorial.

Filter Definition
A filter definition consists of one or more statements, called filter elements;
each filter element is based on a single attribute value or measure. The more
filter elements in a filter specification, the more tightly data is constrained.

A filter element is a comparison expression made up of:

■ the name of an attribute or measure.

■ a comparison operator.

■ a value used to evaluate retrieved data. In the case of an attribute
filter, the value is an attribute value. In the case of a measure filter, the
value is a number.
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Filter Definition
Some examples of filter elements are listed below:

■ City = ‘San Francisco’

■ Fiscal Week In (<<Current Period>>)

■ Brand In (‘Alden’,’Barton’,’Lastertech’)

■ Units Sold > 100

These examples all apply to the MetaCube demonstration database. The first
filter is for the Geography dimension, the second for the Time dimension, the
third for the Product dimension. The fourth is a measure filter based on the
Units Sold measure.

Figure 4-3 Filtered report

The report in Figure 4-3 shows the brands of memory chips, hardware
boards, and CDROM drives sold in department stores and retail chains in the
western region. The query that produced this report contained three filters to
limit the data in the report.

■ The report contains data for department stores and retail chains, but
not warehouse stores, requiring a filter on the Channel dimension.
This filter may be defined in one of the following ways:

Channel In (‘Department Stores’,’Retail Chains’),

or
Channel <> ‘Warehouse Stores’
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Comparison Operators for Attribute Filters
■ The report contains unit sales figures for CDROM drives, memory
chips, and hardware boards only, eliminating all other product
subclasses; this requires a filter on the Product dimension. This filter
may be defined as follows:

Product Subclass In (‘CDROM Drives’, ’Memory Chips’, ’Hardware Boards’)

■ The report contains data for the western region only, requiring a filter
on the Geography dimension. This filter may be defined as follows:

Region = ‘West’

Note: Your data warehouse administrator may prevent some attributes that appear
in Query Mode from being available for use in a filter definition.

Comparison Operators for Attribute Filters
Comparison operators designate the test to be applied to eliminate data. The
comparison operators you can use in an attribute filter element are listed in
the table.

Operator Meaning

= equal; the default and most commonly used operator

< > not equal

> greater than; most useful for numeric comparisons

>= greater than or equal to; most useful for numeric comparisons

< less than; most useful for numeric comparisons

<= less than or equal to; most useful for numeric comparisons

In within the specified list; used for both numeric and character string
comparisons

Not In not within the specified list; used for both numeric and character
string comparisons

Like used for pattern matching; the wildcard is % and can be used to
replace 0 or more characters in the search pattern
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Comparison Operators for Measure Filters
The operators >, <, >=, and <= can also apply alphabetical parameters to
string values. For example, the “Alden” brand is less than the “Delmore”
brand, since “A” precedes “D” in the alphabet.

Comparison Operators for Measure Filters
Measure filters constrain data retrieved by a query according to a comparison
expression applied to the actual data values.

The comparison operators that you can use for measure filters are listed in the
table.

Not Like used for pattern matching; the wildcard is % and can be used to
replace 0 or more characters in the search pattern

Is Null is empty

Is Not Null is not empty

Operator Meaning

= equal; the default and most commonly used operator

< > not equal

> greater than; most useful for numeric comparisons

>= greater than or equal to; most useful for numeric comparisons

< less than; most useful for numeric comparisons

<= less than or equal to; most useful for numeric comparisons

In within the specified list; used for both numeric and character string
comparisons

Not In not within the specified list; used for both numeric and character
string comparisons

Operator Meaning
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Using Folders
Using Folders
When you save filters, they are stored in folders and subfolders organized in
a tree structure. The top-level folder is named ROOT; you can create
subfolders in which to organize filters. Your data warehouse administrator
may have created subfolders in which to save your queries.

A DSS System has a single set of folders and subfolders and all users of that
DSS System can see all folders. Folders are used to store both queries and
filters (see Chapter 3, “Stored Queries” for information on public and private
queries).

Listed below are some important things to understand about MetaCube
folders and the objects stored in them:

■ In Explorer, there is no such thing as a private folder. All folders are
visible to all Explorer users.

■ When working in the Filters Tab page, icons that represent queries
are not visible. The same is true when working in the Queries Tab
page: filter icons are not visible.

■ Icons for your own private filters are visible only to you. Similarly,
icons for other Explorer users’ private filters are visible only to them.
Because of this, no single user can view the entire contents of the DSS
System’s folders.

■ A folder cannot be deleted unless it is empty. Because you may not
be able to see all the objects in a folder, it may appear to be empty
when it isn’t. That is, you may delete all your private filters from a
given folder so that it appears empty to you. However, if another
Explorer user has stored objects in that folder or if it contains any
query icons, it is not really empty and cannot be deleted.

Tutorial: Creating and Applying Filters
In this tutorial, you will create and run an ad hoc query; then, you will apply
filters to it and run it again, observing the change the filter makes in the
results. Your filtered report will be the same as that shown in Figure 4-3 on
page 4-8.
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Tutorial: Creating and Applying Filters
Tutorial Steps:

1. Open an Explorer workbook, if necessary and display a new
worksheet.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and dimension icons, as
needed, to perform the steps in this tutorial.

4. To specify the query from the Sales Transaction data source:

a. Double-click the Channel attribute icon in the Channel
dimension.

b. Double-click the Brand attribute icon in the Product dimension.

c. Double-click the Product Subclass attribute icon in the Product
dimension.

d. Drag the Region attribute icon in the Geography dimension to the
Columns drop box.

e. Double-click the Units Sold measure icon.

5. Click the Filters Tab.

6. To select the dimension on which to filter and to name the filter:

a. Click the Create New Filter button on the Filters Tab page
toolbar.

b. In the Choose Filter Group dialog box, click Channel, then click
OK.

c. In the Filter Elements dialog box, type the name of the filter in
the Filter Name text box:

No Warehouses

d. Click the New button.
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Tutorial: Creating and Applying Filters
7. To specify a filter that retrieves data only for Department Stores and
Retail Chains, but not Warehouse Stores:

a. In the Filter Element Definition dialog box, click the Search
button.

b. Drag the Warehouse Stores icon to the Operand box.

c. In the Operator list box, select the not equal symbol ( <> ).

d. Click OK.

e. The Filter Elements dialog box displays the filter you just
defined. Click OK.

Notice that Explorer displays an icon in the Filters Tab page for
the filter you just specified.

8. To select the dimension for the second filter and to name the filter:

a. Click the Create New Filter button on the Filters Tab page
toolbar.

b. In the Choose Filter Group dialog box, click Geography, then click
OK.

c. In the Filter Elements dialog box, type the name of the filter in
the Filter Name text box:

West Only

d. Click the New button.

9. To specify a filter that retrieves data only for the West Region:

a. In the Filter Element Definition dialog box, click Region in the
Attribute list.

b. Click the Search button.

c. Drag the West icon to the Operand box.

d. In the Operator list box, notice the default operator ( = ). Do not
change this operator.

e. Click OK.

f. The Filter Elements dialog box displays the filter you just
defined. Click OK.

Notice that Explorer displays an icon in the Filters Tab page for
the filter you just specified.
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Tutorial: Creating and Applying Filters
10. To select the dimension for the third filter and to name the filter:

a. Click the Create New Filter button on the Filters Tab page
toolbar.

b. In the Choose Filter Group dialog box, click Product, then click
OK.

c. In the Filter Elements dialog box, type the name of the filter in
the Filter Name text box:

Drives/Chips/Boards

d. Click the New button.

11. To specify a filter that retrieves data only for three subclasses of
product:

a. In the Filter Element Definition dialog box, click Product
Subclass in the Attribute list.

b. Click the Search button.

c. Drag the icons for CDROM Drives, Hardware Boards, and
Memory Chips to the Operand box.

d. In the Operator list box, notice that the operator has changed
( In ). Explorer automatically applied the appropriate operator
for more than one operand. Do not change the operator. Click
OK.

e. The Filter Elements dialog box displays the filter you just
defined. Click OK.

Notice that Explorer displays an icon in the Filters Tab page for
the filter you just specified.

12. To apply the filters you created to the query, double-click each filter
icon, in turn. Notice that Explorer automatically places them in the
Filters drop box.

13. Run the query.

14. Close Explorer; or leave it open to do the next tutorial in this chapter.
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Parameterized Filters
Parameterized Filters
You can create Explorer filters that take user input (or parameters) at the time
the query is executed. When a query that includes a parameterized filter
runs, Explorer displays a dialog box prompting for input that completes the
comparison expression(s) for one or more filters applied to the query.

You can apply more than one parameterized filter to a single query. In Figure
4-4, two parameterized filters were applied to a query from the demon-
stration database: one on the City attribute in the Geography dimension and
one on the Company attribute in the Product dimension. Notice that the
single dialog box is structured to accept user input for both the parame-
terized filters.

Figure 4-4 Query Parameters input dialog box

The ... button to the right of each input text box allows you to view a list of all
possible values for the attribute. You may select the value you wish to use in
the query.
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Tutorial: Parameterized Filter
Figure 4-5 List of Values dialog box

The list of attribute values is displayed in the List of Values dialog box, as
shown in Figure 4-5.

The MetaCube demonstration database contains two queries that use param-
eterized filters. To see how parameterized filters work, you can execute either
the Choose Class & Region or the Product by Zip: Choose City query, stored
in the Parameterized Filters folder.

Each time a parameterized query is executed, you can specify input for the
query and obtain results based on that input.

Tutorial: Parameterized Filter
Note: To do the tutorials in this chapter, you must have started Explorer and be
accessing the MetaCube Demo DSS System. If necessary, ask your data warehouse
administrator to configure your version of Explorer to access the MetaCube Demo
DSS System in the MetaCube demonstration database.
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Tutorial: Parameterized Filter
In this tutorial, you will create two parameterized filters and apply them to a
query. When you run the query, and apply the filters, the Query Parameters
dialog box will look as shown Figure 4-4.

Tutorial Steps:

1. In Explorer, open a workbook, if necessary, and display a new
worksheet.

2. Click the Ad Hoc Tab.

3. Specify a query that will report gross revenues from product sales by
city, then by company:

a. Expand the Sales Transactions data source, if necessary, and the
dimensions, as needed.

b. Double-click the City attribute icon in the Geography dimension.

c. Double-click the Company attribute icon in the Product
dimension.

d. Double-click the Gross Revenue measure icon.

4. To display the Filters Tab page, click the Filters Tab.

5. To specify a parameterized filter based on the City attribute:

a. Click the Create New Filter button in the Filters Tab page toolbar.

b. In the Choose Filter Group dialog box, click Geography, then click
OK.

c. In the Filter Elements dialog box, type the name for the filter in
the Filter Name box:

What City

d. Click the New button.

e. In the Filter Element Definition dialog box, click City in the
Attribute list. The word City displays in the Attribute box.

f. Position the cursor in the Operand box and type:

<<Enter City name>>

then click OK.

6. The Filter Elements dialog box displays the filter you specified. Click
OK.
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Tutorial: Parameterized Filter
7. To specify a parameterized filter based on the Company attribute:

a. Click the Create New Filter button in the Filters Tab page toolbar.

b. In the Choose Filter Group dialog box, click Product, then click
OK.

c. In the Filter Elements dialog box, type the name for the filter in
the Filter Name box:

What Company

d. Click the New button.

e. To specify a filter on the Company attribute, in the Filter Element
Definition dialog box, verify that the word Company displays in
the Attribute box.

f. Position the cursor in the Operand box and type:

<<Enter Company name>>

then click OK.

8. The Filter Elements dialog box displays the filter you specified. Click
OK.

9. Apply the two filters you specified to the query. Double-click each
filter icon, in turn. Explorer places each filter in the Filters drop box.

10. Run the query.

11. To complete the information in the Query Parameters dialog box:

a. Position the cursor in each text box and type the name of the city
and the name of the company for which you wish to see data in
the report.

b. If necessary, click the ... button next to each field to see attribute
values for each field. In the List of Values dialog box, click the
Choices button. Click the attribute value to use for the query,
then click OK.

12. Click OK in the Query Parameters dialog box to finish running the
query.

13. Close Explorer.
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Filtering on Time
Filtering on Time
Filtering on time is different from filtering on, for example, city, where city
has absolute values in the data warehouse. Because MetaCube understands
the idea of relative time as well as absolute time, you indicate one or the other
when creating a time filter.

Absolute Time Filter
In a data warehouse, a time dimension table contains absolute values that
Explorer uses when retrieving result sets. For example, you can retrieve sales
data for the first half of 1997 by filtering data using the dates January 1, 1997,
and June 30, 1997, inclusive, to limit the information returned in your query.
This is filtering on absolute time.

Relative Time Filter
A relative time filter allows you to retrieve results for time periods such as the
current week or the last four weeks, regardless of the actual date, or to
compare results for the current time period and the same time period last
year, again regardless of the actual dates. Using MetaCube, you can design
queries that can be executed over time to retrieve data and comparisons for
the most recent data in your data warehouse, without changing the query
itself.

For example, you can run weekly reports that always retrieve the most recent
week’s data. Without the ability to specify relative time, producing a weekly
sales report, for example, would require continuous redefinition of the query
for each report, using absolute dates such as February 13-19 or October 20-26.
A relative time filter remains undefined until the query executes, at which
time MetaCube defines the filter in terms of absolute dates.

To allow you to create relative time filters, MetaCube provides the following
relative time parameters:

■ Current Period

■ Last 2 Periods

■ Last 3 Periods
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Comparing Changes in Data Over Time
■ Last 4 Periods

■ Current Period and Same Period Last Year

The word “period” has no absolute meaning. Its meaning is derived from the
time attribute included in the query. If you included an attribute for fiscal
week in the query, for example, current period means the current week.

The periods provided by Explorer and listed above are commonly used for
standard reports. However, Explorer understands any quantity of time
periods, such as Last 5 Periods or Last 14 Periods. You can use any number
of time periods in your time filter definition. For example, to report data in
one-week chunks for the last 10 weeks, the relative time filter definition is:

Fiscal Week In <<Last 10 Periods>>

When using the Current Period and Same Period Last Year relative time
parameter, The query itself is specified with the Fiscal Week time attribute.

Comparing Changes in Data Over Time
As an example, in an analysis of fourth-quarter sales, the absolute numbers
may be less important than how those numbers compare with fourth-quarter
sales a year ago. Explorer can calculate data changes over time in absolute
terms or in percentages; see Chapter 5, “Explorer Analysis Features.”

When specifying reports that calculate changes over time, it is helpful to
organize the time attribute by column and the other attributes in the query
by row. This provides a readable format in which Explorer can display its
comparison calculation in an additional column of the report.

A report to compare changes in data over time can specify:

■ a relative time filter that compares a current period with the same
period last year and produces two columns of data, one for each time
period being compared.

■ a measure calculation to calculate the absolute or percent change
between the two columns of data.
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Comparing Changes in Data Over Time
Figure 4-6 Report showing absolute change

The report in Figure 4-6 contains, in the first two columns, data for the current
fiscal week and the same week a year ago. The time filter applied to the query
is:

Fiscal Week In (<<Current Period and Same Period Last Year>>)

The third column of the report contains the results of the Absolute Change
measure calculation, showing the difference between the first two columns.
Information on Explorer Measure Calculations is contained in Chapter 5,
“Explorer Analysis Features.”

By applying the relative time filter that compares this week’s data with the
same period last year, MetaCube returns two columns of data. The measure
calculation, Absolute Change, generates an additional column of data
containing the results of that calculation.

Important: When using a relative time filter that compares a current period with the
same period a year ago, the query must contain the corresponding time attribute to
view the actual data.

When returning the measure calculation data for a two-column report,
MetaCube executes the comparison calculation and places the column
containing the results in a third column. When more than two columns are
contained in the report, Explorer interpolates a comparison column after
each successive column. For example, if there are three columns of data,
Explorer inserts a column after column 2 to display the comparison between
columns 1 and 2, and another column after column 3 to display the
comparison between columns 2 and 3.
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Predefined Parameters
Note: Typically, comparative calculations are performed on columns, not rows, of
data. However, there is no requirement to do this. Once you have run the original
query, you can pivot the columns to display data in rows if this makes your report
more readable. The discussions in this guide, however, refer to columns containing
data and comparison values.

Predefined Parameters
Your data warehouse administrator may have defined some parameters that
you can incorporate into filters. When you incorporate a predefined
parameter into a filter definition, you type the parameter’s name, enclosed in
double angle brackets. Associated with a predefined parameter is one or
more SQL statement that retrieves the data for that parameter.

For example, suppose your data warehouse administrator had defined a
parameter named Top Product that, when applied to a query, constrains the
query to retrieve only data about the top-selling product. To use this
parameter, you would specify the following Product dimension filter:

Product = <<Top Product>>

where Top Product is the name of the pre-defined parameter.

When you execute the query, MetaCube automatically executes the SQL
commands associated with the Top Product pre-defined parameter to
identify the top-selling product and return data about it.

Use of a predefined parameter does not cause the Query Parameters dialog
box to display, since no user input is required.
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This chapter describes MetaCube Explorer’s analysis features. These
include:

■ sorting reports.

■ reporting highest and lowest values.

■ computing summary values—grand totals and subtotals.

■ querying more than one data source.

■ incorporating data analysis calculations into reports.

■ using MetaCube’s Sampling feature.

At the end of this chapter, a tutorial provides an opportunity to practice using
some of these features.

Sorting Reports
MetaCube’s sorting capability allows you to specify sort orders for attribute
and measure values in reports. MetaCube’s default sort method for reports is
to sort attribute values in ascending order.

■ In Query or Results Mode, you can sort all rows and columns of
attributes, affecting alphabetical, numerical, and chronological
sorting.

■ In Results Mode, you can also sort columns and rows of data
(measures) in the report.

Sorting Attributes
The sort orders available for attributes are:

■ ascending (the default).
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Sorting Measures
■ descending.

■ none.

The None option means that retrieved attribute values appear in the report
as they were returned from the database.

MetaCube applies sort orders independently to every attribute in a query. In
a break report where two or more attributes occur in subordinated rows or
columns, the first attribute in the query is sorted first. The sort order applied
to any given attribute does not affect the sort order of any other attribute.
Explorer sorts the rows first, then the columns, thereby giving precedence to
the columns.

Sorting Measures
The sort orders available for measures are:

■ ascending.

■ descending.

Measure sorting is done after running a query. You may sort measures by
column or by row (if measure data has been pivoted or if there is more than
one column of measure data). In a break report, you can designate that breaks
points in the report should be preserved or you can reformat a break report
so that an entire column or row of measure data is sorted in order, thereby
ignoring breaks.

Sorting does not change the underlying query; it changes only formatting
specifications for the resulting report. Therefore, Explorer does not create a
new worksheet in your MetaCube workbook when you specify changes in
sort order.

Note: MetaCube arranges dates so that the earliest comes first, and the most recent
comes last. If you wish to view the most recent date first, use the sort feature to set
the sort order for dates to descending.
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Reporting Highest and Lowest Values
Figure 5-1 Attribute sort example

In Figure 5-1, company names are sorted in ascending order. The brand
names are sorted in descending order by company.

Figure 5-2 Break report sorted by column

Figure 5-2 shows the same report, sorted by measure in Results Mode.
Explorer has sorted the entire report, starting with the rows. The entire data
column was then sorted in descending order, irrespective of the row breaks.

Reporting Highest and Lowest Values
Explorer’s Top/Bottom N feature allows you to generate a report that
contains information for a set of measure values (“N” values) meeting one of
the following criteria:

■ The highest measures in the result set.
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Reporting Highest and Lowest Values
■ The lowest measures in the result set.

■ The top of the result set by percent.

■ The bottom of the result set by percent.

Figure 5-3 Audio sales by city

For example, the report in Figure 5-3, generated from the MetaCube demon-
stration database, shows sales of audio equipment by city.

Figure 5-4 Top selling products cities for audio products: using Top/Bottom N

By comparison, the query that produced the report in Figure 5-4 used the
Top/Bottom N feature to retrieve information on the three top-selling cities
for audio equipment sales.

The Top/Bottom N feature does not automatically sort the measures. You can
sort them using Explorer’s report sorting feature described in the section
“Sorting Reports” on page 5-3.

The report shown in Figure 5-5 retrieved net profit for sales of audio,
computer, and video products for the last four weeks, by city. Applying the
Top/Bottom N feature resulted in a report showing the top three cities.
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Computing Summary Values
Figure 5-5 Three most profitable cities by product class: Top/Bottom N feature applied

In this report, the first column, showing net profit for audio products, shows
the top three cities to be Boston, Palo Alto, and San Francisco. However, the
second and third columns do not display the top three cities for computer
and video products; rather, they simply display data associated with the top
three cities for audio sales.

Figure 5-6 Pages of product class report

If you organize this report by page for product class, as shown in Figure 5-6,
Explorer now processes each page separately and the resulting three-page
report shows the top three cities for each class of product—audio, computer,
and video. Notice that although Boston was one the top three most profitable
cities for sales of audio and computer equipment, Oakland replaces Boston
in the list of top three most profitable cities for video sales.

Computing Summary Values
MetaCube can compute summary values for attributes at any level in a
report. Summary calculations you can request include:

■ Sum.

■ Average.

■ Count.

Page 1: Audio Page 2: Computer Page 3: Video
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Grand Total Calculations
■ Minimum.

■ Maximum.

MetaCube can calculate grand totals for all rows and columns in a report. You
can also obtain subtotal calculations by attribute at the break points in a
report.

Grand Total Calculations
You can specify grand total calculations in either Query or Results Mode.
Because the MetaCube analysis engine computes the grand totals, if you add
them to an existing report; Explorer displays them in the same worksheet.

Figure 5-7 Grand total report

The sales report in Figure 5-7 shows grand totals by both row and column. In
this report, Explorer has added a footer row in which total sales for each
district are shown and a column containing cross-totals for sales for each
brand.

Subtotal Calculations
Explorer can calculate subtotal values for a report organized into subordi-
nated rows or columns—a break report. When you subdivide attributes in a
report, MetaCube can insert subtotal calculations at each break point.
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Reports from More Than One Data Source
Example Subtotal Report

The format of the break report in Figure 5-8 allows MetaCube to calculate
subtotals for each region in the report.

Tip: Not all measures are appropriate for totaling. For example, in the demonstration
database, totaling the Percent Margin measure does not produce meaningful results.

Figure 5-8 Break report showing all possible Explorer subtotal calculations

The sample break report in Figure 5-8 illustrates all the summary calculations
provided by Explorer—total, average, count, minimum, and maximum. You
can request as many summary calculations as you want in any given report.

Reports from More Than One Data Source
You can specify an Explorer query to retrieve and display, in a single report,
data from any data sources in the DSS System you are accessing. This feature
allows you to generate an Explorer report that analyzes similar information
stored in separate data sources. The single requirement is that the data
sources used for such a report must have dimensions in common.
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Reports from More Than One Data Source
In the DSS System for the demonstration database, three dimensions—
Product, Geography, and Time—are exactly matching dimensions in both the
Sales Transactions and Competitive Data data sources. Therefore, these three
dimensions can be used to combine data from the two data sources.

Figure 5-9 Sales report from the Sales Transactions data source

The sales report shown in Figure 5-9 was retrieved from the Sales Transac-
tions data source and contains sales information by region for all brands in
the Product dimension.

The Competitive Data data source in the demonstration database also
contains a Product dimension, which contains sales information for compet-
itors. The attribute names in the Product dimensions for these two data
sources match exactly.

Figure 5-10 Competitive sales added to the basic sales report
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Analyzing Data Values with Measure Calculations
In Figure 5-10, competitive sales information has been added to the basic
report, producing, in a single report, information that can be easily read and
analyzed.

Analyzing Data Values with Measure Calculations
Often, data becomes more meaningful when it is compared with other data.
You can design queries and format Explorer reports to compare measure data
to:

■ rank values

■ show differences between two values

■ calculate running totals

■ calculate percentage of totals.

Explorer’s measure calculation feature provides many report options to
calculate comparison information to enable more in-depth analysis of report
data.

This table lists Explorer’s measure calculation options.

Measure Comparison What It Displays
Normal measure as its actual number; used to remove an

existing calculation for the measure
Absolute Change difference between the current value and the

previous value, displayed as a number (negative
numbers display with a minus sign)

% Change result of dividing the numeric difference by the
previous value; expressed as a percent

% Of Previous result of dividing the current value by the previous
value, expressed as a percent

Rank sequential numbers indicating ranked order of
measure values; 1 indicates highest rank (largest
number)

Bottom Rank sequential numbers indicating ranked order of
measure values; 1 indicates lowest rank (largest
negative number, or, for all positive numbers,
smallest positive number)
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Analyzing Data Values with Measure Calculations
Note: If measures have been pivoted in Results Mode, Explorer displays comparisons
in rows rather than columns.

Running Total sum of the current measure value and all previous
values in the same column (or row if report has been
pivoted)

% Of Row/Column Total comparison between the current measure value and
the sum of all values in the column (or row, if the
report has been pivoted), expressed as a percent

% Of Page Total comparison between the current measure value and
the sum of all values on the page, expressed as a
percent

% Of Report Total comparison between the current measure value and
the grand total of all values in the report (across all
pages)

% Of Orthogonal
Row/Column

comparison between the current measure value and
the sum of the entire row that contains it (or column
if the report has been pivoted)

% Of Subtotal comparison between the current measure and the
subtotal of which it is a part, expressed as a percent

Quantiles similar to rank; comparison among all measures in a
column (or row, if the report has been pivoted)
according to some number of user-defined
groupings (quantiles); 1 indicates the highest
quantile ranking. For example, setting the Quantiles
to 3 divides returned data into 3 groups (tertiles); a
setting of 4 divides data into quartiles; a setting of
100 divides data into percentiles.

Moving Average average of a set of measures that includes the current
measure and some user-defined number of previous
measures in the column (or row, if the report has
been pivoted); if the number of measures to be
averaged is less than the user-defined number (for
example, at the beginning of the report), the actual
number of measures available is used for the
calculation.

Moving Sum sum of a user-defined set of measures that includes
the current measure and some number of previous
measures in the column (or row, if the report has
been pivoted); if the number of measures to be
summed is less than the user-defined number (for
example, at the beginning of the report), the actual
number of measures available is used for the
calculation

Measure Comparison What It Displays
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Absolute and Percent Change
Absolute and Percent Change
Explorer’s change calculations compare data values that appear in two
separate columns.

Absolute Change Calculation

The Absolute Change calculation shows the numeric difference between two
values. By default, positive numbers are unsigned; negative numbers are
signed.

Percent Change Calculations

The % Change calculation reports the percent of change between two values.
This calculation is the result of dividing the numeric difference between the
current value and the previous value by the previous value and expressing it
as a percent.

Figure 5-11 Report illustrating measure calculations that compare measure data

The report in Figure 5-11 illustrates the two measure calculations that
compare data values.

The report shows revenues for all brands for the current week and the same
week a year ago. The Rev Difference column (that uses the Absolute Change
measure calculation) shows the difference in revenues for the two time
periods. The % Chg in Rev column shows the difference in revenues, stated
as a percent.
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Ranking Data Values
Percent of Previous

A slightly different percentage calculation, % of Previous, is the result of
dividing the current value by the previous value, expressed as a percent.

Ranking Data Values
Explorer’s ranking features compare data values within a single column of
data.

Explorer’s ranking features include:

■ Rank.

■ Bottom Rank.

■ Quantiles.

The Rank calculation assigns 1 to the largest value within the column, 2 to the
second largest value, and so forth. Conversely, Bottom Rank assigns 1 to the
smallest number in a column.

Note: The Rank measure calculation ranks all data returned by the query. If you wish
to eliminate some data, one way to achieve this is to apply the Top/Bottom N feature
to the query. The Top/Bottom N feature is discussed in detail in the section
“Reporting Highest and Lowest Values” on page 5-5.

Figure 5-12 Sales report showing rankings by brand for two regions

As illustrated in Figure 5-12, for each column of data in a report, Explorer
displays the results of the ranking calculation in an adjoining column.
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Ranking Data Values
Unlike comparison calculations, which require at least two columns of data
in order to be computed, ranking calculations can be applied to a single
column of returned data.

Quantiles

The Quantile feature allows you to rank data into a number of user-defined
ranking groups, called quantiles. For example, you might generate a report
showing sales figures divided into three ranked groups. Explorer evaluates
the sales data returned from the query and gives each value a ranking of 1
(for the highest rank), 2, or 3 (for the lowest rank).

Figure 5-13 Report showing ranking and quantiles of unit sales for the Northwest region

To illustrate how Explorer determines quantile rankings, the report in Figure
5-13 shows product subclass sales for a single region.

■ The first column shows the actual sales data (number of units sold,
by brand for the Northeast region).

■ The second column shows sales ranked into tertiles (three quantiles).

■ The third column shows sales ranked from highest (1) to lowest (13).
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Running Totals
To assign quantile rankings in this report, Explorer first ranked the unit sales
values (as shown in the Ranking column), then divided the highest rank
number for this report (13) by the number of quantiles for this report (3). The
result determined the number of values assigned to each quantile group.
Therefore, sales ranked from 1 to 4 were placed in the first quantile, sales
ranked from 5 to 8 were placed in the second quantile, and sales ranked from
9 to 13 were placed in the third quantile.

Setting a Quantile value of 3 divides data into three groups, or tertiles; setting
a Quantile value of 4 divides data into quartiles. Setting a Quantile value of
100 divides data into percentiles. As with rank and bottom rank, a report
needs to contain only a single column of data in order to be ranked by
quantiles.

The default number of quantiles in which to group returned data is specified
in Explorer’s Preferences. However, you can specify any value at the time you
apply the Quantile measure calculation in a query. Explorer Preferences are
discussed in Appendix B.

Running Totals
The Running Total calculation sums, for each row in a column, the current
value and all values in previous rows within that column.

Figure 5-14 Running total report
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Other Percentage Comparisons
For the report in Figure 5-14, Explorer calculated running total values for the
Units Sold column and displayed the result in the adjacent Running Total
column.

Other Percentage Comparisons
Explorer provides a number of percentage calculations that allow you to
compare individual values in a column of data with:

■ the total of the column that contains the value

■ the total of the page (in a multi-page report) that contains the value

■ the total of the entire report

■ the total of the row of which the current value is a member

■ subtotals in a break report

and display the comparisons as percentages.

Comparing Data with Report Subtotals and Totals

Using the % Of Row/Column Total measure calculation, Explorer compares
individual values in a column with the total of the column itself (or row, if the
report has been pivoted).

Using the % Of Subtotal measure calculation, Explorer compares individual
values in a column to the subtotals in a break report. The report itself does
not need to display the subtotals for the percentage calculation to be run.
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Other Percentage Comparisons
Figure 5-15 Percent of totals report

The sample report in Figure 5-15 illustrates the use of % of Subtotal and % of
Row/Column Total calculations.

■ The Gross Revenue column shows gross revenues by brand, subto-
taled by company.

■ The Pct of Subtotal column shows, for each row, the percentage of the
subtotal for each company.

■ The Pct of Column Total column shows, for each row, the percentage
of the entire column total.

When specifying the % of Subtotal measure calculation, you must specify the
attribute to be used as a basis for the subtotal percentage calculation.
Explorer lists all the attributes contained in the query so that you can select
the one you wish to use.

The % Of Page Total and % Of Report Total measure calculations function
similarly, calculating, respectively, percentages based on an entire page of a
multipage report and percentages based on values contained in an entire
report.
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Moving Comparisons
Percent of Orthogonal Row/Column

The % Of Orthogonal Row/Column calculation compares the value within a
single cell of a column of data with the values contained in the row of which
that cell is a member. If the report has been pivoted, this measure calculation
does the opposite: it compares a single value in a row with values contained
in the column of which it is a member.

Figure 5-16 Percent of orthogonal row report

The example report in Figure 5-16 shows revenue data for the two regions in
the demonstration database—Northeast and West—with grand totals for
each brand.

In each row of this report, the Gross Revenue columns show sales revenues
for a single brand—one column for each region. The Grand Total column
displays total revenues for each brand. This is the orthogonal row total.

For each individual revenue figure shown at the intersection of a region
column and a brand name row, an adjacent column, labeled Pct of Cur Row,
shows a percentage value that is the result of dividing the individual revenue
figure in that cell by the grand total of revenues for that brand.

Moving Comparisons
Moving sums and averages are calculated on a user-defined set of data
points. This set of data points always includes the current value plus some
number of previous values. For example, a set of four data points for a
moving calculation includes the current value and the three previous values.
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Formatting a Query for Measure Calculations
Figure 5-17 Moving average report

The report in Figure 5-17 calculates a moving average based on two data
points. That is, the value used for each moving average calculation is the
average of the current value and the previous value. The report displays:

■ actual weekly sales in the Units Sold column.

■ the moving average calculation in the Avg Units Sold column.

The Avg Units Sold column displays the average of this week’s and last
week’s sales, thereby smoothing out, somewhat, the peaks and valleys of the
sales figures.

The moving sum calculation works in a similar way to total the current value
and some number of previous values.

The default number of data points to use in the calculation is specified in
Explorer’s Preferences. However, you can specify any value at the time you
apply the Moving Sum or Moving Average measure calculation to a query.
Explorer Preferences are discussed in Appendix B.

Formatting a Query for Measure Calculations
When you incorporate measure calculations into a report, you format your
query to provide a place to display the results of the calculation.
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Formatting a Query for Measure Calculations
Typically, you want your report to display the actual data returned for a
given measure as well as the results of the measure calculation (ranking,
change, percentage, and so on) that is based on the same measure. So, you
must specify:

■ one or more column to display actual data.

■ one column to display the results of a measure calculation.

Each measure calculation you wish to include in a report must be entered as
a separate query item.

Figure 5-18 Report ranking sales of products by brand

Figure 5-18 shows an example report that displays:

■ actual weekly unit sales by brand in the Units Sold column.

■ the ranking (from 1 to 9) of unit sales for each brand in the Ranking
column.

The report has been sorted by column so that rankings and sales figures are
listed from highest to lowest.
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Estimating Results
Estimating Results
Explorer’s Sampling feature allows you to attain improvements in retrieval
time for queries to very large DSS Systems. Running against large database
tables can cause queries to run slowly. The MetaCube Sampling feature
provides a solution to improve query performance against large data tables.
Your data warehouse administrator can create smaller tables, called sample
tables, and incorporate these tables into a DSS System. Sample tables are
statistically accurate, randomly generated data tables. By running queries
against sample tables, you can query small subsets of very large data tables
and obtain results that are statistically accurate to your pre-defined level of
confidence.

Using a MetaCube software component called the Sampler, your data
warehouse administrator can create sample tables for a DSS System. For
example, a sample table containing 10,000 records could be randomly created
from an original table containing 100,000,000 records. For you and other
Explorer users, querying against the 10,000-row sample table results in
noticeable performance improvement as you run queries against a much
smaller table.

Getting Accurate Results Faster
In order to use Explorer’s Sampling feature, you need to:

■ Configure Explorer for Sampling Confidence and Sampling
Accuracy by setting the Explorer Preferences related to Sampling.

■ Enable the Sampling feature with Explorer.

Even if Sampling is disabled, the Slow Query Warning provides the oppor-
tunity to execute the query against sample tables if you have previously set
the Sampling Confidence and Sampling Accuracy Preference values. Infor-
mation on Explorer’s Preferences is contained in Appendix B

Sampling Options
When you configure Explorer for Sampling, you assign a numeric value that
defines for the MetaCube analysis engine the sampling confidence and
accuracy you wish for the query you are running.
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Sampling Options
■ Sampling Confidence: This setting is related to the level of confi-
dence to expect in the report data when you estimate results. The
higher the Sampling Confidence level you request, the wider the
range of possible error in the data in your report. Conversely, as you
set Sampling Confidence to a lower value, the range of error gets
smaller. Typical settings for percent of confidence are in the 90s—
somewhere between 90 and 99. Many samples (such as political
polls, for example) indicate a 95% confidence level.

Other possible settings might include 75% and 50%. Below 50%,
results tend to become meaningless. At 50% confidence level, the
ranges of error for the values in your report will generally be quite
small.

Since the range of error is different for every data value in a given
report, Explorer allows you to view the margin of error for each
value displayed in your report. After running an Explorer report
using the Estimate Results feature, you can display, in Results Mode,
the margin of error for each data value. The margin of error is stated
in terms of  some number.

As an example, suppose you set Sampling Confidence at 95%. After
running a report, one of the data elements in the report is 155 and
Explorer indicates a margin of error of 12. This means that you can
be 95% confident that the real value of that data element falls within
a range of 143 to 167.
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Tutorial: Explorer’s Analysis Features
■ Sampling Accuracy: This setting is related to the relative accuracy of
the results of your queries against the sample tables.Your data
warehouse administrator may have created more than one sample
table. In this case, your accuracy selection tells the MetaCube
analysis engine which sample table to query. If you set the accuracy
level low, at, say, 1, the MetaCube analysis engine will run the query
against the smallest sample table available. The benefit to you is that
query performance is very good; results will be returned fast.

On the other hand, if you set the Sampling Accuracy to 99, the
MetaCube analysis engine will run the query against the largest
sample table available (not the original table, however).

The exact effect of a given Sampling Accuracy setting depends upon
the number of sample tables available against which MetaCube can
choose to run the query. By setting Sample Accuracy somewhere
within the range of 1 to 99, you are giving guidelines to MetaCube
about the tradeoff between performance and accuracy that you want
for your reports.

Note: The MetaCube demonstration database contains sample tables and you can set
up Explorer to run queries that estimate results. In the resulting reports, you can
view the margin of error for the data elements. However, because the demonstration
database is so small, you cannot really observe noticeable improvements in perfor-
mance since even complex queries run very quickly.

Tutorial: Explorer’s Analysis Features
The tutorial in this section gives you practice using some of Explorer’s
analysis features.

For this tutorial, you will use the Sales Transaction data source within the
MetaCube Demo DSS System and you will apply the following analysis
features to a query:

■ Sorting attribute values.

■ Subtotals and grand totals.

■ Querying two data sources.
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Tutorial: Explorer’s Analysis Features
Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. Open Explorer and, if necessary, open a workbook and display a new
worksheet.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and its dimensions, as
needed, to perform the steps of this tutorial.

4. To specify the basic query:

a. Double-click the Region attribute icon in the Geography
dimension.

b. Double-click the Brand attribute icon in the Product dimension.

c. Double-click the Units Sold measure icon.

5. To retrieve data from another data source (Competitive Data):

a. Expand the Competitive Data data source icon.

b. Double-click the Units Sold measure icon.

c. To provide a more meaningful name for the second Units Sold
measure column, right-click the Units Sold_1 icon, then click
Rename.

d. Rename the measure icon using the same methods you use when
renaming Windows operating system files. Type the name:

Competitor Units Sold

6. To apply a filter to the query:

a. Click the Filters Tab.

b. Double-click the Public Filters folder.

c. Double-click the Current Time Filters folder.

d. Double-click the Current 4 wk Period filter to place it in the
Filters drop box.

7. Click the Ad Hoc Tab.
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Tutorial: Explorer’s Analysis Features
8. To sort the brands in descending alphabetical order:

a. Right-click the Brand attribute icon in the Rows drop box.

b. Point to Sort on the shortcut menu, then click Descending. The
descending order sorts from z to a.

9. To subtotal region sales for all brands:

a. Right-click the Region attribute icon in the Rows drop box.

b. Click Subtotals in the shortcut menu.

c. In the Subtotals dialog box, click Sum, then click OK.

10. To display the Grand Totals dialog box:

■ For Client/Server Explorer, click Grand Totals on the Query
menu.

■ For Web Explorer, click the Grand Totals button on the toolbar.

11. To obtain grand totals for the report, in the Grand Totals dialog box,
click Sum in the Grand Total Rows by list. Click OK.

12. Run the query; save the workbook, if you wish.

13. Close Explorer.
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This chapter provides information about Explorer reporting features.
This chapter discusses:

■ the report screen.

■ pivoting, or reformatting, reports.

■ analysis features available in reports.

■ report properties and information.

■ printing reports.

■ exporting report results.

■ working with reports offline.

At the end of this chapter, a tutorial provides an opportunity to practice using
some of these features.

About Explorer Reports
By default, when you run a query, Explorer displays the results in a report.
When viewing an Explorer report, you are using Results Mode.
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About Explorer Reports
Figure 6-1 Explorer’s Report screen

Figure 6-1 shows Explorer’s report screen. It consists of:

■ the report itself.

■ pivot handles that allow reformatting of the report.

■ the worksheet tab that identifies the worksheet containing both the
underlying query and the report generated by the query.

In Figure 6-1, the report shows unit sales by brand for the Northeast and West
regions, broken out into columns by sales channel.

A detailed description of the report screen is contained in the section
“Explorer Reports,” in Chapter 2, “Getting Started with Explorer.”
6-4 Explorer User’s Guide



Pivoting Reports
Pivoting Reports
You can reformat a report so that it presents data in different orientations. For
example, you can move rows of attributes so that they display in columns; or,
move measure data to display in rows. You can move rows or columns of
attributes so that they display a page at a time. This is called pivoting the
report. When you pivot a report, you do not actually change the data in the
report, you reformat the report to display the results differently.

Figure 6-2 Pivoted Report: compare with Figure 6-1

Figure 6-2 shows the same data as contained in the report in Figure 6-1, but
the format is different. The report has been pivoted. The new format displays
sales data in two columns by region rather than three columns by channel.
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Analysis Features in Reports
Analysis Features in Reports
In Results Mode, you can add more data to a report by accessing some of the
analysis features available in reports.

Totals and Subtotals in Results Mode
In Results Mode, you can add both grand totals and subtotals to a report. A
complete description of MetaCube’s grand totals and subtotals feature is
contained in Chapter 5, “Explorer Analysis Features.”

Drill Up/Drill Down
MetaCube’s drill up/drill down functionality allows you to view different
levels of summarized data for the attributes in a report. Drilling down or up
on an attribute value in Results Mode:

■ creates a new worksheet containing a new query definition.

■ displays new summarized data in a new report.

■ retains the original query and its report in the old worksheet.
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Drill Up/Drill Down
Figure 6-3 Sales report, by region, for all brands

In Figure 6-3, a query returns a report by region of brands sold.

Figure 6-4 Drill-down sales report: product-level detail for Alden brand

Drilling down on the Alden brand produces a similar report, but summa-
rized at the next level down, as shown in Figure 6-4.
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Drill Up/Drill Down
When you drill down, you filter out some of the information in the original
report, since you are asking for more detailed information on a single
attribute only. However, if you configure Explorer to do so, it will retain a
reference, in the new report, to the attribute from which you drilled. This is
illustrated in Figure 6-4.

The drill up operation produces a more summarized report; that is, it
contains less detail. MetaCube, in this case, retrieves data at the next higher
level in the dimension hierarchy. Unlike drilling down, which filters out
some of the data in the original report, the drill up operation produces a
report that encompasses, at a minimum, all the values contained in the
original report. Therefore, the particular attribute value selected does not
matter, the summarized report includes all the data at the next higher level.

Figure 6-5 Drill up sales report: company-level summarization includes all brands

For example, in the original brand sales report by region, shown in Figure 6-3,
drilling up on any brand name produces the report shown in Figure 6-5.

You can drill up or down on an attribute organized either by column or by
row.

Multiple Drill Paths

A hierarchy can branch, thereby having more than one path along which to
drill.
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Drill Up/Drill Down
The demonstration database illustrates this in its Time dimension. The Fiscal
Week attribute, the base attribute in the hierarchy, is the point where the
hierarchy branches into three separate paths, moving upward through the
dimension.

Figure 6-6 Time branching hierarchy in demonstration database

When you drill up on an attribute where a hierarchy branches, you need to
tell Explorer which branch to follow.

Figure 6-7 Report of unit sales by fiscal week for 1996

Fiscal Week

Fiscal Year

13 Week
Period

4 Week
Period

Fiscal YTD
Explorer Reports 6-9



Drill Up/Drill Down
The report in Figure 6-7 contains unit sales information for the year 1996,
including a grand total. If you were to drill up on this report, Explorer would
prompt you for the consolidation path to follow; you could follow one of
three paths:

■ 4 Week Period.

■ 13 Week Period.

■ Fiscal YTD.

If you were to select 4 Week Period, the resulting report would show units
sales figures summarized in groups of 4-week periods.

Figure 6-8 Report showing unit sales by 4-week periods for 1996

Notice that the grand total amount of sales is the same as in the previous
report. However, sales are summarized at a level higher because of drilling
up in the Time dimension from the Fiscal Week level to the 4-Week Period
level.

If you had selected either the 13-Week Period or Fiscal YTD path, however,
the resulting report would be summarized for one of those time periods.

When you drill in Explorer reports, you move along the path one level at a
time; it is not possible to skip levels.

Drilling Down to Multiple Attributes at the Same Level

Dimensions may be designed to include multiple attributes at the same
hierarchical level. In the Product dimension of the demonstration database,
for example, the Product and UPC attributes both describe individual
products at the lowest level of the hierarchy.
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Drill Across
Figure 6-9 Product dimension in the MetaCube demonstration database

For any level in a dimension’s hierarchy where there are multiple attributes,
your data warehouse administrator has identified one as the default
attribute. Therefore, if you drill to a level where there are two or more
attributes, Explorer automatically drills to the default attribute and displays
values for it in the resulting report.

In the demonstration database, the default attribute for the product level of
in the Product dimension hierarchy is the Product attribute. Therefore, if you
drill down in the Product dimension, Explorer automatically selects Product
attribute values to display in the report, not UPC values.

Drill Across
In Results Mode, Explorer’s drill across functionality allows you to:

■ Add attributes from other dimensions to a report, thereby adding
new rows or columns of attribute values at subordinated levels.

■ Add measures to your report, thereby increasing the amount of data
shown in the report.

Drilling across:

■ Creates a new worksheet containing a new query definition.

■ Generates a report with additional data or further levels of detail for
the existing data.

■ Retains the original query and report in the old worksheet.

Product Class

Product Subclass

Company

Brand

Product UPC Code
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Drill Across
Figure 6-10 Basic report: Unit sales by Product Class

A basic query for unit sales by product class produces the report shown
above in Figure 6-10.

Figure 6-11 First Drill Across report adding channel subdivisions

The report shown in Figure 6-11 is the result of drilling across to add another
attribute to the report. The addition of the Channel attribute causes the sales
data to be subdivided to produce the break report containing more detail for
the existing data. This is shown above in Figure 6-11.
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Drill Across
Figure 6-12 Second Drill-Across report adding region subdivisions

Drilling across again to add another attribute, Region, produces the report
shown in Figure 6-12. Subtotals by product class can be compared with the
data in the original basic report, shown in Figure 6-10. Subdividing the basic
report with two drill across operations adds two levels of detail to the report
and creates a break report on which to calculate subtotals.

You can also drill across to add more measure data to a report. When you add
measure data, it may be from any data source in your DSS System. Since the
dimensions used for drilling across must exactly match, Explorer prevents
your using an incorrect dimension for drilling across.

Figure 6-13 Units sold by product class
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Report Information
A basic report, shown in Figure 6-13 above, can be expanded to incorporate
additional measure data by drilling across.

Figure 6-14 Drill-across report with gross revenue and net profit shown

In Figure 6-14, gross revenue and net profit data have been added by drilling
across to measures.

Report Information
In Results Mode, Explorer makes available, on the screen, some information
about the current report that may be useful to you.

■ Report creation date.

■ Sampling Accuracy setting.

■ Sampling Confidence setting.

■ Filter(s) applied.

The report information about the current report provides a quick summary
of some key parameters about the report. This information displays on the
screen, but cannot be printed.

Report Properties
You may specify report properties or characteristics that affect how a report
displays on the screen as well as how it prints. Default report properties are
set using Explorer’s Preferences. However, you can change report properties
on a report-by-report basis.

You can individually customize the appearance of reports and the report
screen, itself, for each worksheet. Properties for an individual worksheet
override the Explorer-wide defaults.
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Pivoting Features
The features that you can customize on a report-by-report basis are described
below.

Pivoting Features
You can specify pivoting capabilities for a report as follows:

■ Pivoting: You can enable/disable the ability to pivot a report. By
default, pivoting is enabled. In addition, you can display/remove
row, column, or page pivot handles from the report screen. Pivot
handles are used to pivot reports. If the handles do not display on the
screen, pivoting cannot be performed. By default, pivot handles are
displayed and enabled.

■ Pivot handles: You can specify the size of the pivot handles. This is
useful to accommodate a long attribute or measure name.

Fonts/Colors Features
The features of the Explorer screen for which you can define fonts are listed
in the table below.

Explorer’s default font settings are:

■ Font—MS Sans Serif.

■ Font style—regular.

■ Size—eight point.

■ Script—Western.

Feature What It Is

Pivots Handles that enable pivoting of reports

Results Measure data in the report

Headers Areas of the report that contain column headings (attribute values
and measure names)

Summaries Areas of the report that contain subtotals

GrandTotals Areas of the report that contain grand totals
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Fonts/Colors Features
The features of the Explorer screen for which you can define colors are listed
in the table below.

Information on setting Explorer-wide default report properties is contained
in Appendix B.

Feature What It Is

PivotsBackColor Background color for pivot handles

PivotsForeColor Color of font on pivot handles

Band1Color You may define up to four background colors for the rows
in a report. Each color alternates with as many others as
you specify. For example, if you define two band colors—
white and green—alternate rows of the report will be
white and green.

Band2Color

Band3Color

Band4Color

ResultsBackColor Unused; band colors override this setting

ResultsForeColor Color of font that prints measure data

HeadersBackColor Background color for all areas that contain attribute values
or measure names

HeadersForeColor Color of font that prints attribute values and measure
names

SummariesBackColor Background color for sub-total calculations

SummariesForeColor Color of font that prints sub-total calculations

GrandTotalsBackColor Background color for grand total calculations

GrandTotalsForeColor Color of font that prints grand total calculations
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Printing Results
Printing Results
Explorer provides several options that you can apply as you print a report.
For example, you can individualize reports by creating a header and footer
for each page of the report. Also, you can adjust margins for a printed report
so that it appears exactly where you want it on the page. Another way to
control the positioning of the report is to center it vertically or horizontally,
or both.

In the Header and Footer fields of a report, you can include, in addition to
text, many formatting codes that allow you to produce customized reports.
The table below lists the codes that can be used to specify Headers and
Footers for reports.

Code Usage

Font Codes:

&B Use a bold font

&I Use an italic font

&U Underline the header/footer text

&S Strikes through the header/footer text with continuous
hyphen line

&”fontname” Use the specified font; double quotes are required

&nn Use the specified font size. Must be a 2-digit number

Format Codes:

&L Left-aligns the text that follows.

&C Centers the text that follows. By default, headers and footers
for Explorer reports are centered.

&R Right-aligns the text that follows.

&D Prints the current date.

&N Prints the total number of pages in the report.
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Printing Results
Font codes must precede any other code or text, or they are ignored. Unless
otherwise specified (using &L or &R), headers and footers are centered on
each page of the report. Codes may be typed in uppercase or lowercase
letters.

You can combine alignment codes and font codes to print a header or footer
with separate elements. For example, the print specification:

&L&”Helvetica”&D&C&&”Palatino”&A&R&”Helvetica”Page &P of &N

prints the following three-part header or footer.

5/7/97 Worksheet1 Page 1 of 5

You may change font style immediately after each alignment code.

You can also set the standard Windows print setup options when printing
Explorer reports.

The procedures for printing a chart differ from those for reports. For infor-
mation on printing charts, refer to Chapter 7, “Explorer Charts.”

&T Prints the current time.

&F Prints the name of the worksheet.

&A Prints the name of the worksheet. Used as default for
Explorer report’s page heading.

&P Prints the current page number. Used with the word “Page”
as the default for Explorer report footers.

&P+n Prints the page number plus n.

&P-n Prints the page number minus n.

&& Prints an ampersand.

Code Usage

&N Prints the total number of pages in the report.
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Exporting Report Results
Exporting Report Results
In Results Mode, Explorer provides features for copying reports or report
data to other Windows tools and applications. The copy and export options
are available in Results Mode.

Export to Microsoft Excel
If Microsoft Excel software is installed on your PC, you can copy query
results from Explorer directly to an Excel spreadsheet. If Excel is not already
open, copying to Excel opens the application and places data from your
report in a new Excel workbook.

A setting in Explorer’s Preferences determines whether data is copied into a
standard spreadsheet or into an Excel PivotTable. Excel PivotTables provide
analysis and reporting features for multi-dimensional data sets.

Note: If any attributes in your report are organized by column, Excel PivotTable
cannot accept the Explorer data.

Export to Microsoft Access
If Microsoft Access software is installed on your PC, you can export reports
to an existing Microsoft Access database. In the Access database, Explorer
creates a new table. The table is named after your query and contains the data
in the report. Explorer automatically creates Access database fields of the
appropriate data types and names them based on the definition of the query
that created the report.

Export to a Text File
You can export your report to a text file. The text file contains your data in
comma-delimited form, with double quotes around strings.
Explorer Reports 6-19



Copy to the Clipboard
Copy to the Clipboard
You can copy a selected portion or all of a report to the Windows clipboard.
You can paste into other Windows applications using standard Windows
paste methods.

Working Offline
Explorer provides features that allow you and other users to work with
reports and charts offline. This section discusses:

■ mailing workbooks.

■ using a workbook offline.

Mailing a Workbook
MetaCube Explorer is integrated with mail systems so that you can mail a
workbook as an attachment to a mail message, just as you do any other
document, spreadsheet, or graphic file. MetaCube uses the standard MAPI
mail interface; any mail system that supports the MAPI interface can be used
to send and receive MetaCube workbooks.

You can attach a MetaCube workbook to a mail message in any mailing
system that allows attachments.

The recipient of your MetaCube workbook can view and print your reports
and charts. Thus, you can easily share the results of your queries with other
Explorer users.

The recipient of your MetaCube workbook can also run queries contained in
your workbook if they are also connected to the same DSS System against
which the queries were originally created. However, if you have used any
filters in your queries, they must be public filters. Other users do not have
access to your private filters and, therefore, they might not get the same
results when running a filtered query.
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Using a Workbook Offline
Using a Workbook Offline
You can perform the following tasks when working offline from the data
warehouse:

■ customize report properties for individual reports.

■ pivot the data in a report.

■ sort a report or chart.

■ rename, delete, copy a query, or rearrange worksheets in the
workbook.

■ create a chart from any report.

■ reformat a chart.

Note: Although you can perform these operations offline, you cannot save any
changes you make to a workbook offline. To change a workbook, you must be
connected to a DSS System.

If connected to a printer, you can print reports and charts, as well. If
connected to your network, you can mail the workbook to other Explorer
users.

When you are working offline, you cannot perform tasks, such as drilling up
or down, that require access to the DSS System or require refreshing of data.

Tutorial: Analysis Features in Reports
The tutorial in this section gives you practice using some of Explorer’s report
features. For this tutorial, you will use the Sales Transaction data source
within the MetaCube Demo DSS System.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

In this tutorial, you will perform the following operations in Results Mode:

■ Pivot a report.

■ Drill up and drill across in a report.
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Tutorial: Analysis Features in Reports
■ Sort a report.

■ Add subtotals and grand totals to the report.

■ View report properties.

Tutorial Steps:

1. If necessary, open a new workbook in Explorer or display a new
worksheet.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and its dimensions, as
needed, to perform the steps in this tutorial.

4. To specify the basic query:

a. Double-click the Product attribute icon in the Product dimension.

b. Drag the Region attribute icon to the Columns drop box.

c. Double-click the Units Sold measure icon.

5. Run the query.

6. In Results Mode, pivot the report:

■ Drag the Region name from the upper right-hand corner pivot
handle and drop it on top of the Product pivot handle.

When you start to drag, the cursor appears as a special “pivot”
cursor and valid drop areas are highlighted. When the pivot
cursor is over a valid drop area, the background for the pivot
handle becomes yellow. Release the mouse button to drop the
attribute name you are pivoting.

Notice that, as a result of pivoting, you have created a break
report with Region at the outer level and Product subordinated
at the inner level.

7. Drill up to in the report to view more summarized data by brand.

a. Click in one of the cells in the Product column.

b. Click the Drill Up button on the toolbar.

Because you are using attributes in a branching dimension, you
must indicate to Explorer which path to use when drilling up.

c. In the Choose Drill Direction, click Brand, then click OK.

Explorer reruns the query and displays the results in a new
worksheet.
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Tutorial: Analysis Features in Reports
8. In the report, drill across to the Competitive Data data source to add
a Competitive Data Units Sold column to the report.

a. Click one of the data cells in the Units Sold column.

b. Click the Drill Across button on the toolbar.

c. In the Drill Across Measures dialog box, click the Units Sold
measure icon in the Competitive Data data source, then click
OK.

9. To sort measure data in the report in descending order (from largest
number to smallest number):

a. Click a cell in the Units Sold column of the report.

b. Click the Sort button on the toolbar.

c. In the Sort Measures dialog box, click the Sort Column check
box, then click the Descending button. Click OK.

10. To sort the Brand column in descending alphabetical order:

a. Click a cell in the Brand column of the report.

b. Click the Sort button on the toolbar.

c. In the Sort dialog box. click Brand in the Sort Report On list, then
click Descending. Click OK.

11. To add subtotals to the report for each region:

a. Right-click the Region pivot handle in the lower left-hand corner
of the worksheet.

b. Click Subtotals on the shortcut menu.

c. In the Subtotals dialog box, click Sum, then click OK.

12. To access the Grand Totals feature:

■ For Client/Server Explorer, click Grand Totals on the Query
menu.

■ For Web Explorer, click the Grand Totals button on the toolbar.

13. To add grand totals to the report:

a. In the Grand Totals dialog box, click Sum in the Grand Total
Rows by list.

b. Click OK.

14. Print the report, if you wish, using Explorer’s default print settings.

15. Close Explorer.
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This chapter describes Explorer charts and presents an overview of
the capabilities of Explorer’s charting feature. This chapter discusses:

■ chart options and how to format queries to obtain the desired
charting result.

■ creating readable charts.

■ chart formats.

■ charting options.

■ analysis functions available in charts.

A detailed online help system for Explorer’s chart feature provides specific
information on the use of the various charting features.

At the end of this chapter a tutorial provides an opportunity to practice using
some of these features.

About Explorer Charts
Explorer chart types include the following:

■ Two-dimensional or three-dimensional pie chart

■ Two-dimensional or three-dimensional bar chart

■ Two-dimensional or three-dimensional line chart

■ Two-dimensional or three-dimensional area chart

Explorer automatically sizes, labels, and orients the chart. It also titles the
chart with the name of the worksheet from which the chart was generated.
Explorer charts the attributes organized by rows along the horizontal x-axis
of the chart, the measures along the vertical y-axis of the report, and the
attributes organized by columns as different colors, and, where possible, on
the z-axis in three-dimensional charts.
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Pie Charts
Pie Charts
The two-dimensional pie chart displays data as a fraction of a whole, with
each fraction shown as a segment of the pie. While not suited to tracking
change over time, the two-dimensional pie chart offers a comparative view
of a measure divided into different components.

Figure 7-1 Company sales by Region

The format of the chart is determined by the position (row or column) of the
attributes in the query. For example, in the demonstration database, a query
requesting unit sales by company (with the Company attribute in the
Columns drop box) produces a single pie chart in which each different
segment represents total sales for one of the three companies. Adding Region
information to the report (in the Rows drop box) causes the chart to display
two pies, each corresponding to a region. Figure 7-1 shows the resulting two-
dimensional pie chart.

You can chart data in a variety of formats, either in Results Mode, after
executing a query, or directly from Query Mode. After charting retrieved
data, you can change the report back to a spreadsheet format, if you wish.
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Pie Charts
For a break report, Explorer charts each subordinated row separately. For
example, Figure 7-2 shows the chart for a query that retrieves unit sales by
channel and region (in rows) and brand (in columns). Each combination of
channel and region is a separate pie. The size of the pies reflect the total unit
sales for each channel/region combination: retail chains in the West of the
highest sales, warehouse stores in the northwest have the lowest sales.

Figure 7-2 Pie chart of break report

Figure 7-2 shows some of Explorer’s chart formatting capabilities used to
create a readable and printable chart:

■ The title has been customized.

■ The legend is displayed.

■ Sales of the Delmore brands are highlighted by dragging its pie
segment away from the pie.
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Pie Charts
Graphing a query that tracks sales over time in a pie chart format is useful
only when attempting to understand what fraction of some typical measure,
such as sales, occurs in different periods of time. For example, Figure 7-3
shows a set of pies that tracks sales of product classes over a given time
period.

Figure 7-3 Pie chart

The chart in Figure 7-3 results from a query that retrieves unit sales for
product classes (organized by column) over the past five fiscal weeks
(organized by row and filtered to retrieve only five weeks of data). The pies
have been formatted to highlight sales of audio equipment.

Three-dimensional pie charts present data in the same format as two-dimen-
sional pie charts, but the charts themselves are raised at an angle to the page,
adding a depth perspective to the chart view. This perspective conveys no
additional information, however.
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Bar Charts
Bar Charts
A two-dimensional bar chart emphasizes the difference between two values
in a given range or period of time. Measures are represented along the
vertical y-axis and attributes organized by rows are represented along the
horizontal x-axis. Attributes organized by columns are represented by
different-colored bars that also run along the x-axis. To simplify a bar chart,
limit or eliminate values organized by columns, so that only a few bars
appear in the chart.

For example, Figure 7-4 shows a two-dimensional bar chart of sales for the
last four fiscal weeks (organized by row) for the Soundbyte Company’s
brands (brand, organized by column and filtered to include only the
company named Soundbyte) in which the colored bars represent sales for
each brand.

Figure 7-4 Bar chart
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Bar Charts
A three-dimensional bar chart tracks the different-colored bars of a two-
dimensional bar chart in a third dimension, facilitating comparison across
rows in one direction and across columns in the other. In three-dimensional
bar charts, Explorer tracks the different-colored bars of a two-dimensional
bar chart in different slots along the z-axis, with each slot charting bars of a
particular color. The measure defines the y-axis, each column of data defines
a different slot across the z-axis, and each row is charted along the x-axis.

Figure 7-5 Three-dimensional bar chart

The chart in Figure 7-5 shows results of a query similar to that for Figure 7-4,
except that only three brands—Alden, Barton, and Delmore—are shown.
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Line Charts
Line Charts
A two-dimensional line chart typically graphs a variable over time, although
this chart can also be useful to track the relationship between any two
variables. Separate lines represent each column from the report and the rows
display along the horizontal x-axis. The measure displays along the y-axis. If
you select more than one measure, the chart contains two sets of lines on the
same-scale y-axis. To generate a two-dimensional chart for a query
requesting information as it changes over time, track time in rows.

Figure 7-6 Line chart

This line chart was produced from the same query as the one used to produce
the three-dimensional bar chart in Figure 7-5.
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Area Charts
A three-dimensional line chart plots lines from a standard line chart as
uniform-width bands. As with three-dimensional bar charts, each different-
colored band in a three-dimensional line chart tracks in a separate slot along
the z-axis, corresponding to a separate attribute (located in the Columns drop
box) in the query.

Area Charts
Figure 7-7 illustrate how an area chart reports information. The query that
produced the chart below retrieves, for a four-week period (in rows), unit
sales by product class (in columns).

Figure 7-7 Area chart
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Creating Readable Charts
For the first reporting week (97/03/04 to 97/03 /10), sales of audio
equipment—the lowest area in the chart—are something under 500 units.
When computer sales—the next area of the chart—are added for the same
week, total sales total over 1000 units. Adding video sales—the top area—
total sales of all classes of product are close to 2000 units.

For the week of 97/03/11 to 97/03/17, audio sales are up somewhat. Adding
computer sales, total sales are over 1000, and, adding video sales, total sales
for the week are above 2000 units.

The third and fourth columns can be read in a similar way. For the third
column, although audio and computer sales are higher, decreases in both
video sales bring total sales for all product classes down. Likewise, in the
fourth reporting week, sales for all product classes decrease, causing total
sales to fall below total sales for the first week.

In the stacked format, three-dimensional area charts render two-dimensional
area charts at an angle, to show depth. This perspective conveys no
additional information. If the area chart is unstacked, the area chart then
represents only a filled-in line chart and a three-dimensional view arranges
each line in a separate track on the z-axis. In this instance, a three-dimen-
sional area chart affords a view of areas that may be obscured in a two-
dimensional chart.

Creating Readable Charts
To generate meaningful charts, keep the following in mind:

■ Consistent Units: As a general rule, include only one measure in
your query, since different measures are not directly comparable. For
example, attempting to chart revenues and units sold on the same
scale produces two different lines or sets of bars that differ widely in
magnitude, preventing Explorer from appropriately scaling the
charts to the data.

For similar reasons, you should avoid charting measure calculations,
such as % Change and Rank, or summaries. The numbers returned
by these functions are not always directly comparable to the raw data
in your report and tend to distort the resulting charts.
Explorer Charts 7-11



Charting Options
■ Number of Attributes: Use only a single attribute in the Columns
drop box in the query. When possible, filter data returned for that
attribute. Every value organized by columns is included in the
legend. To prevent the chart from becoming too complicated, it is a
good idea to limit the values appearing in the legend. For example,
to chart sales over time for a particular brand, format the query so
that Brand is in column orientation and filter on Brand to select only
the data in which you are interested. If you do not filter on Brand, the
graph will show every brand and the chart may be difficult to read.

Charting Options
Right-clicking a chart displays a shortcut menu of charting options. This
menu allows you to format existing charts and to generate new types of
charts not accessible from the toolbar.

In the dialog box for each chart option is a Help button. You can access online
help for complete instructions on formatting your chart using the chart
program’s extensive library of chart types and formatting features.

You can open the formatting dialog boxes for a particular component of a
chart by double-clicking a chart component, such as the title of the chart, one
of the chart’s axes, or a series being tracked on the chart.

The various options on the chart shortcut menu allow you to work with
Explorer charts.
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Chart Wizard
Chart Wizard

Figure 7-8 Chart Wizard dialog box

Using the Chart Wizard, you can edit your existing chart to:

■ reformat it into another chart style (in the Gallery tab).

■ select from one of many formatting styles for the chart style you
currently have (in the Style tab).

■ add or edit a title, footnote, or legend for your existing chart (in the
Layout tab).

■ add or edit axis labels for your chart (in the Axes tab).

The Chart Wizard allows you to step through the chart formatting process a
tab at a time, using the Next> and <Back buttons.
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Edit Chart Data
Edit Chart Data
You can locally change the data charted by Explorer. However, if you do this,
the underlying data for your chart will not match data stored in the DSS
System. Changing data values in the chart program has no effect on data
values in the database tables.

General
You can frame and provide a background for your chart as well as display or
hide the chart title, legend, footnotes, and, in three-dimensional charts, the
numbering along the second y-axis. You can also choose to format charts for
printing or for display on your computer monitor.

You to use your own bitmap file or Windows metafile as a custom
background fill.

Plot
There are many options that affect the format of the chart itself. Depending
on the type of chart, some tabs may be unavailable.

Series
You can set format characteristics for a series of data or a data point within a
series of data separately, so that you can change the color of a particular line,
or the shape of a particular bar, without changing the entire chart.

Axis, Legend, Title, Footnote
You can format the grid, the axis labels, and the scaling on the x, y, and z axes.

In addition, you can set the appearance, font, location, color, and framing of
a chart’s legend, title, and footnote. You can also re-title a report, or add a
footnote if one does not already exist.
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Copy, Paste, Print, Save As, Load
Copy, Paste, Print, Save As, Load
These features work as you would expect for your Windows environment.
Page Setup and Print Setup Tabs available from a chart are different from the
Print dialog box opened from Explorer’s toolbar.

Finally, in the chart screen, you can save and load charts, but not the queries
that generated the charts. To save or load a query, use Explorer’s Query
Mode.

Analysis Features in Charts
When working with charts, you are in Explorer’s Results Mode; some
Explorer features are available to use.

Explorer features you can use to manipulate charts include:

■ Top/Bottom N filter: you can filter your chart data to display either
top or bottom ranking data. Explorer’s Top N filter is described in the
section “Reporting Highest and Lowest Values” on page 5-5.

■ Drill Up/Down/Across: you can drill up, down, or across in charts
just as you do in a report. To activate Explorer’s Drill feature, select a
data point (or handle) in the chart:

❑ In a pie chart, click a pie segment. Explorer displays the handle
for that segment.

❑ In a bar chart, click a bar. Explorer displays the handle for that
bar.

❑ In a line chart, click a point where the line changes direction.
Explorer displays a handle for that point.

❑ In an area chart, click a point at which the area forms an angle.
Explorer displays a handle for the angle.

Tip: If you have created a chart based on a query with multiple
attributes in rows or columns, you may need to click twice to isolate a
single data point.

Once a single data point is selected, you can drill up, down, or
across. Explorer’s Drill Up/Drill Down and Drill Across features
are described in Chapter 6, “Explorer Reports.”
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Tutorial: Using Charts
Tutorial: Using Charts
The tutorial in this section gives you practice using some of Explorer’s chart
features. For this tutorial, you will use the Sales Transaction data source
within the MetaCube Demo DSS System.

In this tutorial, you will perform the following operations:

■ Create a pie chart.

■ Highlight data in the pies.

■ Change the format to display a three-dimensional chart.

■ Title the chart and change the font style for the title.

■ Display and position the chart legend.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. If necessary, open a new workbook in Explorer and display a new
worksheet.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and its dimensions, as
needed, to perform the steps in this tutorial.

4. To specify the basic query:

a. Double-click the City attribute icon in the Geography dimension.

b. Drag the Brand attribute icon to the Columns drop box.

c. Double-click the Units Sold measure icon.

5. Create a pie chart:

■ For Client/Server Explorer, click the 2D Pie Chart button on the
toolbar.

■ For Web Explorer, click the Choose Report or Chart button on the
toolbar, then click Pie.
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Tutorial: Using Charts
6. Drag the Techno Components segment slightly away from each pie
to highlight this data. To drag a pie segment:

a. Click the pie segment you wish to move.

b. Click and drag the pie segment.

7. Reformat the chart into a three-dimensional bar chart:

■ For Client/Server Explorer, click the 3D Bar Chart button on the
toolbar.

■ For Web Explorer, click the Choose Report or Chart button on the
toolbar, then click Pie.

8. Pivot the bar chart to the left to make the chart more readable. To
pivot a bar chart:

a. Press down the CTRL key. Notice that the form of the cursor
changes.

b. Grab the bar chart and swing it to the left, slightly, so that bars
and the label for the Extreme brand become more visible.

9. Create a new title for the chart and change the title’s font:

a. Right-click anywhere in the chart.

b. Click Title in the shortcut menu.

c. Click the Text Tab.

d. In the Text box, select the current title text and type a new title:

Chart Tutorial

e. Click the Font Tab.

f. Select a different font for the title. Change the Font Style and/or
Size, if you wish. Click OK.

10. Display and position the chart’s legend:

a. Right-click anywhere in the chart.

b. Click Legend on the shortcut menu.

c. In the Location Tab:

1. Click the Visible check box.

2. Click the Bottom button.

d. Change the font, font style, and size for the legend text.
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Tutorial: Using Charts
11. Reposition the components of the chart—title, bar chart, and
legend—to fit well in the screen. To move chart components, click in
or near a component so that its handles display. Do one or both of the
following

■ Drag the handles to resize the component.

■ Click and drag the entire component to reposition it.

12. Print the chart, if you wish; then close Explorer.
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This chapter describes the features of MetaCube Explorer that allow
you to produce customized reports. These include:

■ custom summarization of data using buckets.

■ highlighting important groups of data using color or symbols.

■ custom comparison queries.

■ user-defined measures.

■ renaming attributes and measures.

■ snap-ins for customized measure calculations for Explorer.

Also included in this chapter is information on:

■ viewing system messages from your data warehouse administrator.

■ viewing the SQL statements sent to the database by Explorer.

In this chapter a tutorial provides an opportunity to practice using some of
these features.

Custom Summarization of Data: Buckets
Explorer provides a feature that allows you to customize reports by defining
groups of attributes to use as the basis for summarizing data. As part of your
query definition, you can organize attribute values into a set of user-defined
groups, called buckets, thereby summarizing data to meet your own specific
reporting requirements.

Grouping Attribute Values into Buckets
Buckets are based upon existing attribute values and are defined by grouping
attribute values according to one of the following mechanisms:
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Grouping Attribute Values into Buckets
■ Ranges of alphabetic or numeric values.

■ Sets of specific items (attribute values).

■ A combination of ranges and selected items.

The ability to define a set of buckets allows you to create query categories that
are different from those originally defined in your DSS System.

Figure 8-1 Report of sales summarized by product subclass

In the demonstration database, you can define a query that returns sales
totals for all subclasses of product. If the basic query includes a grand total
calculation, it produces the report shown in Figure 8-1.

Figure 8-2 Report of sales by user-defined buckets

In the report shown in Figure 8-2, product subclass sales information is
organized into a set of two buckets:

■ PC equipment.

■ Home entertainment equipment.
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Bucket Definitions
All product subclasses have been grouped into one or the other of these two
user-defined buckets which determine how data is summarized in the report.

Bucket Definitions
Bucket definitions are specified on a query-by-query basis and are saved with
that query in a workbook or in the database.

Buckets by Alphabetic or Numeric Range

One method of defining a set of buckets is by alphabetic or numeric range of
attribute values. Each bucket is defined by a range of values. The entire set of
bucket values starts with the lowest value stored in the data warehouse and
runs up to the highest value stored in the data warehouse for the given
attribute.

In Explorer, each individual range is specified using a threshold value that is
the top of the range. For the first bucket, Explorer automatically begins the
range with the lowest value stored. For each succeeding bucket, Explorer
defines the range starting with the next value higher than the threshold for
the previous range and ending at the next threshold value you specify. The
last range is automatically defined by Explorer; it extends from the next value
higher than the last threshold you specified up to the highest stored value.

Note: For alphabetic ranges, values are case sensitive in the data warehouse. Be sure
that character values are entered exactly as they appear in the database.

Each set of buckets has a name. The name appears as the query category for
the bucket set and replaces the attribute name. Within the set, each bucket is
labeled. This label takes the place of individual attribute values and is
displayed in the results, along with its summarized data.

When specifying alphabetic ranges, you may use a single character or
character strings to delimit the ranges.
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Bucket Definitions
Buckets by Selected Attribute Values

Another method of defining a set of buckets is by specifying the exact
attribute values to be included in each bucket. The entire set of buckets has a
name. The name appears as the query category and replaces the attribute
name. Within the set, each bucket is labeled. This label takes the place of
individual attribute values and is displayed in the results, along with its
summarized data.When defining the contents of buckets by selecting values,
you may include the same attribute value(s) in more than one bucket. You
may also eliminate some attribute values from inclusion in any bucket.

To assist you in selecting items to be included in buckets, Explorer displays
all the available attribute values in a list. You may select the values you wish
to include in each bucket.

Tip: When selecting alphabetic values, using the list provided by Explorer assures
that the value contained in your query will match exactly the value stored in the
database.

Custom Buckets

The custom buckets feature allows you to mix and match the way you define
buckets. In a single custom bucket specification, you may:

■ define one or more buckets using a range of values.

■ define one or more buckets by selecting specific values from a list of
values.

■ lump together “unbucketed” values into a single “Other” bucket.

■ eliminate values by not including them in any bucket.

The custom buckets feature allows you to include the same attribute value or
values in more than one bucket.

The entire set of buckets has a name. The name appears as the query category
and replaces the attribute name. Within the set, each bucket is labeled. This
label takes the place of individual attribute values and is displayed in the
results, along with its summarized data.

When defining a custom bucket by range, you can specify a range to begin
and end with any arbitrary value. Custom ranges do not need to begin with
the smallest value or end with the highest value stored in the database. Also,
ranges for custom buckets may overlap.
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Tutorial: Specifying Buckets
A feature of the custom bucket definition process allows you to define a
range that includes all values below or above a given threshold. You can use
the word ALL in the range specification. For example, a specification of:

<ALL> To 50

defines a range that includes all numeric values less than or exactly equal to
50 (including negative values). A specification of:

100 To <ALL>

defines a range that includes all values exactly equal to or greater than 100.

The ALL option allows you to define ranges that include values at the low
and high ends of the entire set of values for the attribute you are custom
bucketing. You do not need to know (or specify) the actual lowest or highest
value.

As an example, the following range specifications include every possible
value for an attribute whose values are alphabetic characters.

Tutorial: Specifying Buckets
Follow the steps below produce a report with the following information:

■ For the east and west coast cities, product sales by class

■ A comparison between east and west coast sales, showing the
difference between sales for those two areas

■ Grand totals of unit sales for the east and west coast cities

Definition Range

<ALL> To Dz A (beginning of the alphabet) through D,
including all uppercase as well as
mixed-case alphabetic values

E To Lz E through L, including all uppercase as well
as mixed-case values

M To Rz M through R, including all uppercase as well
as mixed-case values

S To <ALL> S through the end of the alphabet
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Tutorial: Specifying Buckets
Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. Start Explorer and, if necessary, open a new workbook.

2. Click the Ad Hoc Tab.

3. Expand the Sales Transactions data source and its dimensions, as
needed, to perform the steps in this tutorial.

4. Specify the basic query:

a. Double-click the Product Class attribute icon.

b. Drag the City attribute icon to the Columns drop box.

c. Double-click the Units Sold measure icon.

5. Right-click the City icon in the Columns drop box.

6. Click Buckets in the shortcut menu. In the Buckets dialog box:

a. In the Name box, type a name for the set of buckets:

East/West Coast Sales

b. Click the Selecting Items only button.

7. To specify the bucket for east coast cities:

a. Click the ... button at the right of the top box in the Items list.

b. In the List of Values dialog box, click the Choices button.

c. From the list of city names, click Boston and New York, using
standard Windows techniques for selecting multiple items in a
list.

d. Click OK.

e. To position the cursor in the Bucket Label box, press Tab. Type
the Bucket Label for the bucket:

East Coast Cities

The name you provide here is used as a heading for the report.
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Tutorial: Specifying Buckets
8. To specify the bucket for west coast cities:

a. Click the next ... button.

b. In the List of Values dialog box, click the Choices button.

c. From the list of city names, click Oakland, Palo Alto, and San
Francisco.

d. Click OK.

e. To position the cursor in the Bucket Label box, press Tab. Type
the Bucket Label for the bucket:

West Coast Cities

The name you provide here is used as a heading for the report.

f. Click OK.

g. Notice the icon Explorer uses to represent the set of buckets you
defined. You have specified your own query category; the
Bucket Labels you typed will appear as column headings in the
report.

9. Specify a calculation that compares sales for the east and west coasts:

a. In the DSS System hierarchy on the Ad Hoc Tab page, double-
click the Units Sold measure icon to place another Units Sold
icon in the Measures drop box. Its name is Units Sold_1.

b. Right-click the Units Sold_1 icon.

c. Click Calculation on the shortcut menu.

d. In the Name box of the Measure Calculation dialog box, type a
name for the measure calculation:

Difference in Sales

This name appears in the report as the column heading for the
measure calculation.

e. Click Absolute Change in the Display As list, then click OK.

10. Run the query.

11. In Results Mode, add grand totals to the report for product classes
and for east and west coast cities. To access the Grand Totals feature:

■ For Client/Server Explorer, click Grand Totals on the Query
menu.

■ For Web Explorer, click the Grand Totals button on the toolbar.
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Highlighting Important Data: Stoplighting
12. In the Grand Totals dialog box, click Sum in the Grand Total Rows by
list, then click OK.

Figure 8-3 Tutorial report: Buckets

The final report for this tutorial is shown in Figure 8-3.

13. Close Explorer, if you wish, or leave it open for the next tutorial.

Highlighting Important Data: Stoplighting
Explorer’s Stoplighting feature allows you to apply colors to ranges of
measure values to highlight them in a report. Alternatively, you can apply
special symbols that display in place of the actual data. Using either
technique, you can visually highlight key information in a report.

Stoplight colors and symbols are applied to measure data by defining ranges
of data values. For example, you could stoplight a report to highlight, in red,
sales and revenue figures that fall below a certain threshold.

A stoplight definition is associated with a single query and is saved with that
query in a workbook or in the database.

When defining ranges of data to stoplight, you start with the lowest range
first. In Explorer, each individual range is specified using a threshold value
that is the top of the range. For the first range, Explorer automatically begins
the range with the lowest value in the retrieved data. For each succeeding
range, Explorer starts with the next value higher than the threshold value for
the previous range and ends at the next threshold value you specify. The last
range extends from the value higher than the last threshold you specify up to
the highest value in the report.

For each range, you can select a color or a symbol to use to display the data
for that range. Explorer supplies a default color or symbol, which you can
change, if you wish.
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Custom Comparison Queries
Tip: To print symbols correctly in your reports, your PC must have the WingDings
font installed.

Custom Comparison Queries
Explorer provides a custom comparison feature that allows you to define a
single query that generates two or more SQL statements to retrieve data. The
retrieved data is displayed side-by-side or as a single integrated list of values.
This feature is useful for retrieving data for several attributes into a single
report without creating a break report. Data retrieved is displayed side-by-
side in several columns or in a single sorted column.

Figure 8-4 Custom comparison report

The report in Figure 8-4 compares unit sales for the city of San Francisco with
unit sales for the entire country. The report also includes a measure calcu-
lation to show what percent of the total sales are made in San Francisco.

The data for country-wide sales is accomplished when the first SQL query is
run. To obtain data specifically for San Francisco, a filter, embedded in the
custom comparison definition itself, filters the second SQL query to obtain
only data for San Francisco. The % of Country Sales column shows the
difference, for each brand, between unit sales for San Francisco and unit sales
country-wide.
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Tutorial: Custom Comparison
Note: Any filters applied within a custom comparison become part of that custom
comparison definition. They have the effect of filtering individually for each SQL
statement issued to retrieve the attribute values you specified in the custom
comparison. This has a different effect from a filter applied outside the custom
comparison definition, which limits data for the entire report.

Tutorial: Custom Comparison
Follow these steps below to specify a query that uses a custom comparison.
For this tutorial, you will use the Sales Transaction data source with the
MetaCube Demo DSS System in the MetaCube demonstration database.

The query you specify will produce a report with unit sales information for
products, by subclass, for the three retail outlets and the two sales regions.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. Start Explorer and, if necessary, open a new workbook and
worksheet.

2. Click the Ad Hoc Tab.

3. To specify the custom comparison, right-click the Columns drop box,
then click New Custom Comparison in the shortcut menu.

a. In the Custom Comparison dialog box, type the name for the
custom comparison in the Name box:

Channel/Region Compare

b. Double-click the Channel dimension icon to expand it, then
double-click the Channel attribute icon.

c. Double-click the Geography dimension icon, then double-click
the Region attribute icon.

d. Click the Sort Separately button, then click OK.
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User-Defined Measures
4. Complete the query:

a. Expand the Sales Transactions data source icon, then expand the
Product dimension in the DSS System hierarchy.

b. Double-click the Product Subclass attribute icon.

c. Double-click the Units Sold measure icon.

5. Run the query.

Figure 8-5 Results of custom comparison query

The results of the tutorial query are shown in Figure 8-5. The format of the
report that results from using a custom comparison allows you to show data
values in separate columns.

User-Defined Measures
Explorer allows you to define a custom measure that you can incorporate into
your queries. A custom, or user-defined, measure is based on measures that
already exist in the data warehouse.

About Measures
Measures are the numeric data items tracked in a DSS System and can be one
of two kinds:
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Measure Constraints
■ Stored: actual numeric values contained in data warehouse tables.

■ Calculated: derived by a formula based on other measure values.

Stored measures track business transactions at your company. Your data
warehouse administrator has probably specified several stored measures in
your DSS System so that you can view this information using Explorer. Each
item of data tracked in your data warehouse is represented in Explorer by a
measure icon.

A calculated measure, on the other hand, is one that is defined by a formula,
based on one or more previously defined measure, either stored or calcu-
lated, to produce additional data items. Values for calculated measures are
computed at the time a query is executed, and, therefore, are always calcu-
lated on the most current data stored in your DSS System.

The MetaCube demonstration database contains:

■ three stored measures: Units Sold, Incurred Cost, and Gross Revenue.

■ two calculated measures: Percent Margin and Net Profit.

As a calculated measure, Percent Margin is not stored as a number in the
demonstration database tables. By storing a formula for calculating percent
margin instead, the MetaCube analysis engine can calculate this value when
a query executes. The formula used to return a value for Percent Margin is
based on Gross Revenue and Incurred Cost, two stored measures.

Your DSS System may include some calculated measures that were specified
by your data warehouse administrator.

Measure Constraints
You can apply a measure constraint (or filter) to your custom measure.
Similar to attribute filters, measure constraints limit the measure values
returned in a report or chart. Although rarely used, constraints are useful to
prevent custom measures from incorporating undesirable values during
calculation. For example, you might define a calculated measure to return the
average price of a product sold; the formula would divide the sum of the
price of all products sold by the sum of products sold. To ensure that the
average price calculation does not attempt to divide by 0 when no products
have been sold, you could apply a constraint to filter out product sums equal
to 0.
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Tutorial: User-Defined Measure
A filter definition consists of three components:

■ An Operand, a previously-defined measure.

■ An Operator, a comparison operator, such as = or <>.

■ A Value, a constant to which the operand is compared.

Tutorial: User-Defined Measure
Follow the steps below to learn about specifying a query that uses a custom
comparison. For this tutorial, you will use the Sales Transaction data source
with the MetaCube Demo DSS System in the MetaCube demonstration
database.

■ The user-defined measure you specify will calculate the average
revenue per unit sold.

■ The query you specify will produce a report with the following infor-
mation for the current week: units sold, gross revenues, and average
revenue for all video products.

Note: To do this tutorial, you must have started Explorer and be accessing the
MetaCube Demo DSS System. If necessary, ask your data warehouse administrator
to configure your version of Explorer to access the MetaCube Demo DSS System in
the MetaCube demonstration database.

Tutorial Steps:

1. Start Explorer and, if necessary, open a new workbook and
worksheet.

2. Click the Ad Hoc Tab.

3. Access the measure definition feature:

■ For Client/Server Explorer, click Define Measures on the Tools
menu.

■ For Web Explorer, click the Define Measures button on the
toolbar.

4. In the Define User Measures dialog box, click Add.
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Tutorial: User-Defined Measure
5. In the Measure Definition dialog box, define a user measure that
calculates average revenue per unit sold:

a. In the Name box, type the name for the measure:

Avg Rev/Unit Sold

a. In the Measures Tab, double-click the FACT(‘Gross Revenue’)
icon.

b. Click the Operators Tab, then double-click the division (/)
operator.

c. Click the Measures Tab, then double-click the FACT(‘Units
Sold’) icon.

6. To format the data for this measure to match the format of other
Explorer measures:

a. Click the ... button in the Format group box at the bottom of the
Measure Definition dialog box.

b. In the Format dialog box, click Currency in the Category list. You
have applied the Currency numeric format to the user-defined
measure. Click OK.

c. Click OK again. Notice that the new user-defined measure is
listed in the dialog box. Click Done.

d. Click Explorer’s Ad Hoc Tab.

e. Expand the Sales Transactions data source. Notice that the user-
defined measure is listed in the DSS System hierarchy.

7. Specify the query using the user-defined measure:

a. Expand the icons in the Sales Transaction data source to
complete the steps in this tutorial.

b. In the Product dimension, double-click the Product attribute
icon.

c. Double-click the Units Sold, Gross Revenue, and Avg Rev/Unit
Sold measure icons.

8. Run the query.

MetaCube calculates the value for the user-defined measure and
places the results in a column labeled with the name you provided
for the measure.

9. Close Explorer.
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Renaming Attributes and Measures
Renaming Attributes and Measures
You may change the names of any of the attributes or measures in an
individual worksheet. Default attribute and measure names are provided by
your data warehouse administrator. If you wish to display names in your
report that are more meaningful to you, you can do so. In the MetaCube
demonstration database, for example, you might like to change the Units Sold
measure name to read Product Sales.

When you change the name of an attribute or measure, it is changed only for
the current worksheet.

You can also redefine the internal specification for an attribute or measure.

Warning: The ability to redefine internal specifications for MetaCube objects is for
special use only and you should not do this unless you are a programmer who is
customizing the Explorer application.

Snap-Ins for Custom Measure Calculations
MetaCube extensions, called snap-ins, provide additional measure calcula-
tions for Explorer. MetaCube snap-in modules are similar to Excel Add-Ins
in that they extend the capabilities of the software to meet specific decision
support needs.

A MetaCube snap-in is written to MetaCube’s C++ application programming
interface (API) and the file itself is identified by the filename extension .mcx.
A single .mcx file many contain one or more MetaCube measure calculations.
After adding a MetaCube Snap-In, its measure calculations are available
immediately.

For Client/Server Explorer, MetaCube snap-ins can be added at any time.
When you snap in a MetaCube extension, you add that module to the copy
of the MetaCube analysis engine running on your PC. The extension is then
available for your use.
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Viewing System Messages
For Web Explorer, your data warehouse administrator snaps in extensions
for the MetaCube analysis engine you access on the MetaCube middle-tier
server. The measure calculations are available, then, for all users who access
that particular copy of the MetaCube analysis engine.

Viewing System Messages
A system message is posted by your data warehouse administrator to
communicate with you and other Explorer users the current status of the
DSS System. For example, the administrator can write system messages
informing users about such things as:

■ when the latest data has been loaded.

■ when the DSS System will be unavailable.

Each message is dated, so you can recognize the most recent information.

Showing SQL
The SQL commands that the MetaCube analysis engine sends to the data
warehouse for any given query can be viewed in Explorer.

Usually it is not necessary to view SQL commands when using Explorer. In
fact, Explorer is designed to hide the technical aspects of querying databases
from users. As an Explorer user, you are probably not interested in learning
about SQL syntax; therefore, you will not view SQL statements frequently, if
at all.

However, your data warehouse administrator may find the ability to view
the SQL commands useful for purposes of troubleshooting. Therefore,
Explorer makes it possible for administrators to have easy access to this
information.

In addition to displaying SQL commands, the Show SQL dialog box displays:

■ the cost of running the query.
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Showing SQL
■ the number of actual SQL commands sent for the current query.
Sometimes, for more complex Explorer queries, the MetaCube
analysis engine actually sends multiple SQL queries to the server,
combining the result sets returned into a single report.
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This chapter provides information on running Explorer queries in
background. This feature is known as QueryBack.

This chapter discusses:

■ Background processing of Explorer queries.

■ Submitting queries to QueryBack.

■ Status of QueryBack jobs.

■ Retrieving results of QueryBack jobs.

Background Processing of Queries
Once you have defined a query, the MetaCube analysis engine generates
database commands in SQL to retrieve the results. Explorer allows you to run
the query directly from your computer or to submit the query for background
processing. Background processing (called QueryBack) allows you to submit
queries to the server thereby freeing your computer to perform other tasks.
You may also use QueryBack to schedule query jobs to run at pre-determined
times so that results will be available when you need them.

To submit a query to QueryBack, MetaCube’s server-side processing agent,
your data warehouse administrator must have granted you background
processing privileges. You may be granted full permission to use QueryBack
at any time, or you may be limited to certain days and hours.

Conversely, your data warehouse administrator may have set your privileges
such that you are precluded from submitting foreground queries at all and
must use QueryBack for all queries you submit.

In either case, after submitting a QueryBack job, you retrieve results in a
separate step, after your QueryBack job has finished running.
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Using QueryBack
QueryBack is not available in all systems. Check with your data warehouse
administrator to find out if this feature is available and, if it is, what your own
QueryBack permissions are.

Using QueryBack
When executing a query, the MetaCube analysis engine issues SQL
commands to the server for immediate execution. While these commands
process on the server, your computer waits for the results to be returned.
Explorer displays the results as either a report or a chart.

The Slow Query Warning
For any query, MetaCube analyzes the database to identify the optimal tables
from which to retrieve the result. However, queries requesting the most
detailed data in the DSS System may require the MetaCube analysis engine
to access very large tables. The MetaCube analysis engine anticipates
possible slow performance and displays the slow query warning.

Figure 9-6 Slow Query Warning

If you receive a Slow Query Warning, you have several options for
continuing. One of the options is to submit the query to QueryBack for
background processing. When the query has completed, you may retrieve
the results.
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Scheduling Queries
Explorer is configured to display the Slow Query Warning when the cost of
running the query exceeds a given threshold. See Appendix B for infor-
mation on configuring Explorer. Your data warehouse administrator can help
you determine what number to set as a threshold for the Slow Query
Warning.

Scheduling Queries
Using QueryBack after receiving a Slow Query Warning is one way to submit
a query to QueryBack. You may also schedule a query for background
processing when you first run it.

Note: If you are configured as a user who can only use background processing for
queries, Explorer will not allow you to submit foreground queries. You must schedule
all queries using the QueryBack feature.

If you submit a query to the server using QueryBack, MetaCube’s server-side
agents perform the following tasks:

■ Schedule the query for execution.

■ Store the SQL commands on the server until they are scheduled to
execute.

■ Execute the commands on the server as a background process.

■ Store the results on the server.

When you schedule a QueryBack job, you can run the query as soon as
possible on the server, or you can specify a time at which to run the query.
This allows you to schedule running of a query during off hours, for example.

In addition, you can also specify recurring times to run a query. You can
specify to run queries daily, weekly, monthly, and annually. If you know, for
example, that new data is loaded into your data warehouse every weekend,
you might schedule a weekly query to process every Sunday night.

At the time you specify a query to run, QueryBack places it in a queue of
queries on the server, to be run as soon as possible. Since the query queue can
include queries from other Explorer users, some delay may occur between
the time you submit a query background job and the time the server actually
executes it.
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Status of QueryBack Jobs
The actual time a query runs depends on the length of the queue, the job’s
priority, when your data warehouse administrator has granted you privi-
leges to run queries, and the number of processors available on the server. Be
sure the clock on your PC is synchronized with the clock on the server, since
a significant difference between the two can delay the running of a
QueryBack job.

A query’s priority determines the precedence your query takes over other
queries in the queue issued by users with similar assigned privileges. Your
data warehouse administrator manages QueryBack privileges, granting
users permissions which in turn affect the order in which queries run. As a
user, you can set a priority for your query. The highest priority you can assign
your QueryBack job is 5. The higher a job’s priority, the sooner it runs.

Status of QueryBack Jobs
After submitting a query to QueryBack, you can monitor the job’s status
Explorer’s QueryBack Tab page.

Explorer allows you to view the details of a QueryBack job, including the
number it is assigned on the server. Also, if an error occurred during
processing, you can view the error message in Explorer.

You can view the following information about a QueryBack job:

■ Job Number: the unique identification number generated for each
job. Your data warehouse administrator tracks pending, running,
and completed jobs on the server using the job ID number.

■ Name: the name of the worksheet from which the job was submitted.

■ Status: the current status of a query.

■ Priority: the priority you assigned to the job when you submitted it
to QueryBack.

■ Submit Time: the time you submitted the job from Explorer.

■ Target Start: the time you requested that the job begin processing.

■ Start Time: the time the job actually executed on the server. Jobs may
not run as soon as they are submitted because of other jobs waiting
in the queue ahead of it, possible downtime of the scheduler process
on the server, or other reasons.
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■ End Time: the time the job completed on the server. When the job has
completed successfully, you can access the results.

Retrieving Results from QueryBack
When your query has completed, you can retrieve the results into a
worksheet in your MetaCube workbook. By default, Explorer returns the
results into the current worksheet. You can change this default, if you wish,
so that Explorer opens a new worksheet in which to display the results; see
Appendix B.
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Appendix
Formats for Numeric Data
This appendix describes Explorer’s numeric data format options.

Your data warehouse administrator has defined default formats
for the display of numeric data in Explorer reports and for the
example report display in Query Mode. However, Explorer
offers many options for formatting numeric data. The formats
you designate in Explorer affect the display of data; it is not
related to the internal format of information stored in the data
warehouse.

You can designate formats for:

■ numeric data retrieved by queries.

■ measure calculations you specify in a query.

■ user-defined measures you create.

Format Options
You can format the following categories of numeric data:

■ Number

■ Currency

■ Accounting

■ Percentage

■ Custom



Custom Format Specifications
When you select a numeric format category, you provide information about
how you wish to see numbers displayed. Explorer’s numeric formatting
options include the following:

■ Number of digits: Used to specify the number of digits to the right
of the decimal point for all numeric format categories.

■ 1000 Separator: Used to specify the comma separator for all numeric
data.

■ Negative Numbers: Used to specify how negative values display;
you can select from one of four options.

■ Dollar sign ($): Used to specify a dollar sign ($) in the display of
currency values.

■ Custom formats: Used to specify one of Explorer’s existing format
specifications, or to specify your own customized format.

Note: Formats for numbers automatically display correctly for the regional setting
configured on the PC. When using custom formats, specify the following characters
using universal symbols, as shown in the table:

These universal symbols are translated into the correct symbols for the regional
setting in effect.

Custom Format Specifications
Custom format options for Explorer are very similar to those used in
Microsoft Excel. Custom format specifications are structured in two sections,
separated by a semi-colon (;). The two sections specify the display for
positive and negative numeric data. The general structure is shown in
Figure A-1.

Universal Symbol Meaning

, (comma) 1000 separator

. (period or dot) decimal point

- (minus sign) negative
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Custom Format Specifications
Figure A-1 Custom format specification syntax

The table lists all the formatting options for custom format specifications and
provides examples of the display of numeric data.

Format Specification Example

0 1

0.00 1.23

#,##0 1,234

#,###0.00 1,234.56

#,##0_);(#,##0) 1,234; negative numbers as (1,234)

#,##0_);[Red](#,##0) 1,234; negative numbers in red as (1,234)

#,##0.00_);(#,##0.00) 1,234.56; negative numbers as (1,234.56)

#,##0.00_);[Red](#,##0.00) 1,234.56; negative numbers in red as (1,234.56)

$#,###0_);($#,##0) $12,346; negative numbers as ($12,346)

$#,##0_);[Red]($#,##0) $12,346; negative numbers in red as ($12,346)

$#,###0.00_);($#,##0.00) $12,345.68; negative numbers as ($12,345.68)

$#,##0.00_)l[Red]($#,##0.00) $12,345.68; negative numbers in red as ($12,345.68)

0% 1%

0.00% 1.23%

0.00E+00 1.23E+13

##0.0E+0 1.2E+13

Format for positive numbers

Format for negative numbers

#,###.00_);[Red](#,###.00)
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The meanings of the symbols used in the format definitions are shown in this
table.

Symbol Meaning

# Digit placeholder; displays a number.

0 (zero) Digit placeholder; displays a number. Displays 0 if no digit fills the
place help by the 0. For example, the format #.00 plays the number
8.9 as 8.90.

$ - + / ( ) :
space

Printing characters.

, (comma) Thousands separator; prints when surrounded by # or 0.

. (period) Decimal point. Used to display fractions as decimal values. Also
used in time formats to display fractions of a second.

% Percentage. The % symbol prints.

_ (underscore) Skips the width of the next character. For example, _) skips the
width of the parenthesis character.

E- E+ Scientific notation format. Number of 0s to the right of the sign
determines the exponent’s number of digits. Plus sign (+) displays
positive exponents with a + and negative exponents with a -.

[Red] Displays characters in the cell in red.
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Appendix
Configuring Explorer
This appendix explains the options available for configuring
Explorer.

Configuration Options
You can specify configuration options in Explorer for the
following characteristics:

■ General characteristics related to queries.

■ Screen fonts and colors.

■ Default values for measure calculations.

■ Formatting defaults for Explorer reports.

■ Type of table to copy to Excel.

■ Confidence and accuracy levels for Sampling.

For Client/Server Explorer, you can also set:

■ Connection information.

Many or all of the options may have been set for you by your
data warehouse administrator. You may decide to change some
of these options after using Explorer for awhile. If you wish to
change a configuration option, consult with your data
warehouse administrator before making these changes.



Fonts/Colors Tab
Fonts/Colors Tab
This tab allows you to configure the fonts and colors of various features of
Explorer screens.

The features for which you can define fonts are listed in the table.

Explorer’s default font settings are:

■ Font—MS Sans Serif.

■ Font style—regular.

■ Size—eight point.

■ Script—Western.

Feature What It Is

General In Query Mode, dimension, attribute, and measure names; labels
for text boxes; lists in text boxes of dialog boxes; text of balloon help
boxes; text entered in some dialog boxes.

Pivots In Results Mode, handles that enable pivoting of reports.

Results In Results Mode, measure data in the report.

Headers In Results Mode, areas of the report that contain attribute and
measure names.

Summaries In Results Mode, areas of the report that contain subtotals.

GrandTotals In Results Mode, areas of the report that contain grand totals.
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General Tab
The features for which you can define colors are listed in the table below.

General Tab
This tab allows you to configure some general features of Explorer. The

Feature What It Is

PivotsBackColor Background color for pivot handles.

PivotsForeColor Color of font on pivot handles.

Band1Color You may define four background band colors to be used
for the rows of a report. Each color alternates with as
many others as you specify. For example, if you define
two band colors—white and green—alternate rows of the
report will be white and green.

Band2Color

Band3Color

Band4Color

ResultsBackColor Unused; band colors override this setting.

ResultsForeColor Color of font that prints measure data.

HeadersBackColor Background color for all cells that contain attribute values
or measure names.

HeadersForeColor Color of font that prints attribute values and measure
names.

SummariesBackColor Background color for subtotal calculations.

SummariesForeColor Color of font that prints subtotal calculations.

GrandTotalsBackColor Background color for grand total calculations.

GrandTotalsForeColor Color of font that prints grand total calculations.
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General Tab
General tab contains the following configuration options:

Slow Query Warning

Before executing a query, MetaCube evaluates the performance cost of
accessing the various tables needed to retrieve results. If a query accesses a
large table, MetaCube may issue a Slow Query Warning, prompting you to:

■ use sample tables when running the query.

■ submit the query to QueryBack.

■ run the query anyway.

■ cancel the query.

Configuration Option Default What It Does

Slow Query Warning 10000 Compared with the Cost field for the fact
or aggregate table to be used for the query.
If the Cost exceeds this number, Explorer
displays the Slow Query Warning.

Maximum Database
Rows to Retrieve

32767 0 means retrieve all rows; any other
number limits the number of rows
retrieved for a report to no more than that
number.

Mandatory Time Filter disabled When checked, Explorer requires that a
time filter be applied to every query. This
restriction helps to prevent very long
running queries that retrieve data for all
time.

Open QueryBack jobs In New
Worksheet

When you ask for the results of a
QueryBack job, Explorer writes data into
either:

■ the current worksheet

■ a new worksheet

in a MetaCube workbook. You may
specify where you wish to have the results
written. If no workbook is open, Explorer
opens a new workbook first.
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General Tab
You can set a threshold for the Slow Query Warning. This value corresponds
to the cost values your data warehouse administrator has assigned to tables
in the data warehouse. The threshold specifies when Explorer should issue
the warning. Before adjusting the Slow Query Warning value, you should
consult your data warehouse administrator.

Maximum Rows to Retrieve

This option allows you to place a practical limit on the size of reports by
limiting the number of rows Explorer returns for all queries. In some cases,
queries can result in reports that take a long time to process and may be too
long to be useful.

Setting this option to 0 causes queries to retrieve all possible rows.

Mandatory Time Filter

This check box allows you to specify whether time filters should always be
applied in queries. If you check this box, your queries must always be filtered
on time; this has the effect of disallowing queries that will retrieve data from
the data warehouse for all time. Activate the Mandatory Time Filter option if
reports for all time will not be meaningful or helpful to you. Then, you will
not inadvertently submit a query for all time that may, possibly, take a long
time to run.

Leave this option disabled if you want the flexibility of choosing whether to
filter on time on a query-by-query basis.

Open QueryBack Job

These buttons allow you to choose the worksheet in which to retrieve reports
submitted to QueryBack. By default, Explorer retrieves results of QueryBack
jobs into the current worksheet. You can configure Explorer to open a new
worksheet when you retrieve the results of a QueryBack job. For
Client/Server Explorer, if a workbook is not currently open, Explorer opens
a new workbook into which to write QueryBack results.
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Report Tab
If you configure Explorer to retrieve QueryBack results to the current
worksheet, it is recommended that, when you view the QueryBack queue
status, you select the Jobs for this Worksheet... option. That way, if the
current worksheet does not match the worksheet in the QueryBack queue,
you will not risk overwriting another worksheet when you retrieve results.

Report Tab
This tab contains the following format options for reports.

Freeze Report Titles

This option controls the ability to view report headings as you scroll a long
and/or wide report in Results Mode. Report Titles are cells that contain the
names of the attributes in the query that generated the report. When Freeze
Report Titles is enabled, cells containing report heading text remain in view
as you scroll the report to display all attribute values. Conversely, when
Freeze Report Titles is disabled, report headings scroll out of view as you
scroll down or across a report.

Option Default What It Is/What It Does

Freeze Report Titles disabled Enables you to retain column and row
headings on the screen as you scroll a
report.

Resize Report Columns enabled Enables you to resize the width of the
columns of a report using the mouse.

Resize Report Rows enabled Enables you to resize the height of the
columns of a report using the mouse.

Keep Summary in
Report after DrillDown

disabled Causes Explorer to retain the name of
the higher level attribute in a report
after drilling down to more detail.

Copy to Excel: As Spreadsheet Explorer copies data to Excel as either:

■ a spreadsheet

■ a PivotTable

You may specify which format to use.
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Report Tab
Resize Report Columns/Rows

The Resize Report Columns and Resize Report Rows options control the
ability to adjust the width of columns and the height of rows in Results Mode.
When Resize Report Columns is enabled, you can resize a column by
positioning the cursor directly on a column boundary at the top of the report.
Then, you can drag the boundary of the column to the right or left to resize
the column.

Similarly, when Resize Report Rows is enabled, you can resize a row by
positioning the cursor directly on a row boundary at the left side of the
report. Then, you can drag the boundary up or down to resize the row.

Keep Summary in Report after DrillDown

When drilling down in Results Mode, Explorer displays only data at the level
to which you have drilled. However, if you activate the Keep Summary in
Report after DrillDown option, the report will retain the name of the attribute
you highlighted before drilling down. This provides a frame of reference for
you in the resulting report. For example, if you drill down on a company
name to get more detailed information, the company name displays in the
resulting report with the drill down attributes as subordinated levels in the
report.

If the Keep Summary in Report after DrillDown option is not enabled, the
drill down operation simply creates a new report without retaining the name
of the attribute from which you drilled.

Copy to Excel

You can designate the format in which Explorer exports data to Excel.
Explorer writes data into Excel as either a spreadsheet or a PivotTable. To
export MetaCube data to Excel, you must have a copy of that software on
your PC; Explorer automatically opens Excel and creates a new spreadsheet
or PivotTable.
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Calculation Tab
Calculation Tab
This tab contains the following calculation options.

Default Number of Quantiles

The number set here determines how many groups (called quantiles) will be
used when ranking data in a report. Used when you apply the Quantile
measure calculation to your report. The number may be changed on a report-
by-report basis.

Default Number of Items for Moving Avg./Sum

This number determines how many values are used when Explorer calcu-
lates a Moving Average or a Moving Sum measure calculation on data in a
report. The default you set with Explorer options may be changed on a
report-by-report basis.

Option Default What It Is/What It Does

Default Number of
Quantiles

3 For measure calculations, the number of
groups into which to divide report data
for ranking. The number 3 divides data
into three groups, or tertiles; the
number 4 divides the data into
quartiles; the number 100 divides data
into percentiles.

Default Number of Items
for Moving Avg./Sum

3 For measure calculations, the total
number of measures on which to
calculate moving averages or sums.

Sampling Confidence 100 Used by the MetaCube analysis engine
for its Sampling feature. When enabled,
allows you to determine the level of
confidence for a report retrieved from
sample tables.

Sampling Accuracy 100 Used by the MetaCube analysis engine
for its Sampling feature. When enabled,
allows you to indicate which sample
table is used for retrieving results.
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Configuration Tab
Sampling Confidence

If Sampling Confidence is set to 100, this effectively disables the Sampling (or
Estimate Results) feature. When Sampling Confidence is set to 100, the
MetaCube analysis engine does not use sample tables when retrieving
results. When Sampling Confidence is set to some number less than 100, this
affects the level of confidence for reports. The higher the Sampling Confi-
dence setting, the wider the margin of error for returned results.

Sampling Accuracy

If Sampling Accuracy is set to 100, this effectively disables the Sampling (or
Estimate Results) feature. When Sampling Accuracy is set to 100, the
MetaCube analysis engine does not use sample tables when retrieving
results. When Sampling Accuracy is set to some number less than 100, the
MetaCube analysis engine determines which of several sample tables to use
for retrieving results from the DSS System.

Configuration Tab
This tab is available only for Client/Server Explorer.

Under this tab, you specify information used for connecting from Explorer to
a DSS System. Your data warehouse administrator may have entered one or
more configurations for the copy of Explorer that runs on your PC.
Configuring Explorer B-9



Configuration Tab
If you need to specify a configuration for connecting to your DSS System,
your data warehouse administrator can provide the information required. To
specify an Explorer configuration, you most complete the following infor-
mation:

Configuration Name: The name of the current set of configuration
parameters. It can be any name, although matching this name with
the name of the ODBC data source to which you are connecting may
provide a logical, meaningful name for a configuration.

Metamodel Schema: The schema/owner of the metadata tables in
the database. For Informix databases, which support table owners,
this value indicates the name of the user who owns the metadata
tables, followed by a dot ( . ). In ANSI-standard SQL, the dot sepa-
rates the name of the table owner from the table name.

For the Microsoft Access database, this value is a prefix common to
all the MetaCube metadata table names. The prefix is not followed by
a dot. Depending on your company’s naming conventions, this value
may end with an underscore character.

DSS System Name: the name of the DSS System to access upon con-
necting to the database. To connect to the MetaCube demonstration
database, enter “MetaCube Demo” in this field.

Database Type: the two database types supported by MetaCube are
Informix Dynamic Server or Microsoft Access.

Data Source: the name of the ODBC User Data Source defined with
ODBC Administrator. If the name here and the ODBC User Data
Source name do not match exactly, no connection can be made. The
ODBC User Data Source name is not case sensitive.

DSS Cache File: this option is obsolete. Do not use.

Informix Parameters:

Defaults for Informix Parameters are set by your data warehouse
administrator. You may change options for the copy of Explorer you
are using, depending on how you have been configured by your data
warehouse administrator.

PDQ Priority: The default value for this parameter is set by your
data warehouse administrator and, if you have been given per-
mission, you may change the setting. This parameter sets queries
submitted by Explorer as PDQ queries. The Informix PDQ (Par-
allel Database Query) feature allows the database to manage
B-10 Explorer User’s Guide



Configuration Tab
resources when processing both OLTP and decision support
transactions. The default value for PDQ Priority is -1; this speci-
fies to use the database server default for processing Explorer
queries. If you enable PDQ processing, you can set the priority
value to a value between 1 (LOW) and 100 (HIGH). (If the num-
ber is zero ( 0 ), PDQ processing is OFF.) For information on PDQ
query processing, refer to the Informix database server
documentation.

Data Skip: The default value for this parameter is set by your
data warehouse administrator and you may change it, if you
wish. This parameter sets the Informix Data Skip feature that
allows a query to complete even when data stored on unavail-
able fragments cannot be retrieved. The effect of turning on Data
Skip is to allow all SELECT statements to complete; all unavail-
able fragments are skipped when a query is processed. However,
operations that write to the database do not complete.

For information on data skipping, refer to the Informix database
server documentation.
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numeric data in

formatting A-1
Quantiles 5-12, 5-14, 5-15
Rank 5-11, 5-14
Running Total 5-12
% Change 5-11
% Of Orthogonal Row/

Column 5-12, 5-19
% Of Page Total 5-12, 5-18
% Of Previous 5-11
% Of Report Total 5-12
% Of ReportTotal 5-18
% Of Row/Column Total 5-12,

5-17
% Of Subtotal 5-12, 5-17

Measures 1-5
adding to a report

by drilling across 6-11
calculated 8-14
custom

constraining 8-14
described 1-5
filtering 4-4
for filters on

comparison operators 4-10
pre-defined 8-14
renaming 8-17
sorting reports by 5-4
stored 8-14
user-defined

formatting A-1
in custom reports 8-13

Menu bar 2-4
Messages

system 8-18
MetaCube demonstration

database 2-3
MetaCube Web Explorer 1-4
Metadata tables B-10
Metamodel Schema parameter

for Explorer connection to the
database B-10

Minimum values

computing a report’s 5-8
Modes

for Explorer’s user interface 1-8
Moving

Average
measure calculation 5-12

averages
configuring number of

measures receiving B-8
comparisons

of data values 5-19
Sum

measure calculation 5-12
Multiple drill paths 6-8

illustrated 6-9

N
Name

of QueryBack job 9-6
Normal

measure calculation 5-11
Numeric data

formatting A-1 to A-4
custom A-2
meaning of symbols A-4
options for A-1

O
ODBC data source B-10
Online help

for Explorer 2-4
Open QueryBack Jobs In option

configuring B-4
setting B-5

Options
charts 7-12

Overview of Explorer 1-3 to 1-13

P
Parameterized filters 4-15
Parameters

predefined 4-22
PDQ Priority parameter
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defining Explorer’s interaction
with database B-10

Percent change calculations 5-13
Percentage comparisons

of data values 5-17
% Of Orthogonal Row/

Column 5-19
% Of Page Total 5-18
% Of Report Total 5-18
% Of Row/Column Total 5-17
% Of Subtotal 5-17

Pie charts 7-3
described 7-4
for break reports 7-5

illustrated 7-5
illustrated 7-4
showing data over period of

time 7-6
three-dimensional

described 7-6
Pivot handles

modifying a report’s 6-15
Pivoting reports 6-15
Predefined parameters 4-22
Printing reports 6-17

headers and footers 6-17
Priority

of QueryBack job 9-6
of user 9-6

Private
filters 4-5
queries 3-8

Public
filters 4-5
queries 3-8, 4-5

Q
Quantiles

default number of
configuring B-8
setting B-8

measure calculation 5-12, 5-14,
5-15

Queries
background processing of 1-12,

2-13, 9-3
defining 3-4

foreground processing of 2-13,
9-4

formatting
measure calculations for 5-20
numeric data retrieved

from A-1
priority of background jobs 9-6
private 3-8, 3-9
public 3-8, 4-5
recurring 9-5
retrieving results of 9-7
saving 3-8
scheduling for execution 9-5
status of background jobs 9-6
stored 3-3 to 3-12

described 3-3
in folders 3-9

Tab 3-3, 3-9
described 2-7

using 3-8
Query

categories 1-5
cost 9-5, B-4

viewing 8-18
Definition Area

Control Area 2-13
described 2-12

icon 3-9
items 1-5
Mode 1-8

described 1-9
screen, described 2-5

Parameters
dialog box 4-16

QueryBack 9-3 to 9-7
introduced 1-12
job parameters

End Time 9-7
Job Number 9-6
Name 9-6
Priority 9-6
Start Time 9-6
Status 9-6
Submit Time 9-6
Target Start 9-6

Tab
described 2-11

R
Range of error

of data in reports 5-23
Rank

measure calculation 5-11, 5-14
Ranking data values 5-14
Readability

of charts, guidelines for 7-11
consistent units 7-11
limited attributes 7-12

Recurring queries 9-5
Regional settings

for formatting numeric data A-2
Relative time filters 4-19
Report properties 6-14
Reporting data

from multiple data sources 5-9
Reports 6-3 to 6-23, 8-3 to 8-19

analysis features 6-6
drill across 6-11
drill up/drill down 6-6
subtotals 6-6
totals 6-6

configuring B-6
attribute names B-6, B-7
column size B-6, B-7
copying to Excel B-6, B-7
headings B-6
row size B-6, B-7

copying to clipboard 6-20
custom

comparisons 8-11
measures, defining 8-13
summarization 8-3

exporting 6-19
to Microsoft Access 6-19
to Microsoft Excel 6-19
to text file 6-19

fonts and colors 6-15
formatting 6-14

pivot handles 6-15
pivoting 6-15

generating 2-22
grouping attribute values 8-3

by ranges of values 8-4, 8-5, 8-6
by specific items 8-4
by specific values 8-6

highlighting data 8-10
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information contained in 6-14
creation date 6-14
filters applied 6-14
Sampling Accuracy setting 6-14
Sampling Confidence

setting 6-14
pivot handle size 6-15
pivoting 6-5, 6-15
printing 6-17
reformatting 6-5
renaming attributes and

measures 8-17
sorting 5-3
stoplighting 8-10
using Buckets 8-3, 8-5
working offline with 6-20

mailing 6-20
workbooks 6-21

Resize Report Columns option
configuring B-6
setting B-7

Resize Report Rows option
configuring B-6
setting B-7

Results
Mode 1-8, 2-22, 6-3

described 1-9
Retrieving results

of background queries 9-7
Right-clicking 2-4
ROOT folder 3-9, 4-11
Rows

configuring report B-6, B-7
Running Total

measure calculation 5-12
Running totals 5-16

S
Sample tables 1-11, 5-22, 5-24
Sampling 2-13, 5-22

Accuracy setting 5-24
configuring B-8, B-9
in reports 6-14

Confidence setting 5-23
configuring B-8, B-9
in reports 6-14

enabling 5-22

introduced 1-11
options 5-22

Saving queries 3-8
Scheduling queries 1-12, 9-5
Series

formatting charts for 7-14
Slow Query Warning 9-4, 9-5

option
configuring B-4

setting threshold B-4
Snap-Ins 8-17
Sort orders 5-3, 5-4
Sorting

alphabetically 5-3
chronologically 5-3
numerically 5-3
reports 5-3

by attributes 5-3
by measures 5-4

SQL
commands

for retrieving query results 9-3,
9-4

number used for query 8-19
for queries

viewing 8-18
Start Time

of QueryBack job 9-6
Status

of query 9-6
of QueryBack job 9-6

Stoplighting data
in custom reports 8-10

Stored
measures 8-14
queries 3-3 to 3-12

defining 3-4
described 3-3
saving 3-8
using folders 3-9

Submit Time
of QueryBack job 9-6

Subtotals
for break reports

computing 5-8
in reports 6-6

Sum of values
in a report 5-7

Summary values

average 5-7
computing for attributes in a

report 5-7
counts 5-7
grand total calculations 5-8
maximums 5-8
minimums 5-8
subtotal calculations 5-8
sums 5-7

System messages 8-18

T
Target Start

of QueryBack job 9-6
Text files

exporting reports to 6-19
Three-dimensional charts

area 7-11
bar 7-8
line 7-10
pie 7-6

Time
as basis of filter 1-7, 4-19
branching hierarchy for 6-9
dimension 1-7

Titles for charts 7-14
Tool Tips 2-4
Toolbar 2-4
Top/Bottom N 5-5
Totals

in reports 6-6

U
Units in charts

consistent 7-11
Universal symbols

for regional settings
needed to format numeric

data A-2
User interface

differences between Explorer
versions 1-4

menu bar 1-4
of Explorer 2-3
toolbar 1-4

User priority
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of query job 9-6

V
Viewing

SQL used for queries 8-18

W
Web Explorer 1-4
Workbooks

introduced 1-10
using 2-16

Working offline
with reports 6-20

mailing 6-20
workbooks 6-21

Worksheets B-4, B-5
introduced 1-10
printing 2-17
using 2-17

Symbols
% Change

measure calculation 5-11
% Of Orthogonal Row/Column

measure calculation 5-12, 5-19
% Of Page Total

measure calculation 5-12, 5-18
% Of Previous

measure calculation 5-11
% Of Report Total

measure calculation 5-12
% Of ReportTotal

measure calculation 5-18
% Of Row/Column Total

measure calculation 5-12, 5-17
% Of Subtotal

measure calculation 5-12, 5-17
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